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Glossary
A list of words or terms specialized in this document.

Glossary Definition

BSP Board Support Package, the layer of software containing hardware-specific drivers and libraries to function in a
particular hardware environment.

CPU Central Processing Unit.

csv Comma Separated Values file.

DRC Design Rule Check.

DUT Design Under Test.

ESI Previous name of Propel.

FPGA Field Programmable Gate Array.

GUI Graphic User Interface.

HDL Hardware Description Language.

HSM Hardware Security Module.

IDE Integrated Development Environment.

IP-XACT An XML format that defines and describes electronic components and their designs.

LHS Left Hand Side.

LSB Least Significant Bit.

MSB Most Significant Bit.

Programmer A tool can program Lattice FPGA SRAM and external SPI Flash through various interfaces, such as JTAG, SPI, and
12C.

Perspective A group of views and editors in the Workbench window.

RHS Right Hand Side.

RISC.V A free and open instruction set architecture (ISA) enabling a new era of processor innovation through open
standard collaboration.

SBX The files that store the spatial index of the features

SDK Embedded System Design and Develop Kit. A set of software development tools that allows the creation of
applications for software package on the Lattice embedded platform.

SoC System on Chip. An integrated circuit that integrates all components of a computer or other electronic systems.

SRAM Static Random Access Memory.

TCL Tool Command Language.

UFM User Flash Memory.

VIP Verification IP.

Workspace The fiirectory whgre stores your work, it is used as the default content area for your projects as well as for
holding any required metadata.

Workbench Refers to the desktop development environment in Eclipse IDE platform.
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1. Introduction

Lattice Propel™ 2.1 Builder is a graphical tool used to assemble complex System-on-Chip (SoC) modules which can be
used in the supported Lattice FPGA devices. These modules and/or IPs can be assembled and connected easily by
simply dragging and dropping the modules and/or IPs into the Schematic Window.

1.1. Purpose
Embedded system solutions play an important role in FPGA system design allowing you to develop the software for a
processor in an FPGA device. It provides flexibility for you to control various peripherals from a system bus.

To develop an embedded system on an FPGA, you need to design the System on Chip (SoC) with an embedded
processor. Lattice Propel Builder helps you develop your system with a RISC-V processor, peripheral IP, and a set of
tools by a simple drag-and-drop.

The purpose of this document is to introduce Lattice Propel 2.1 Builder tool and design flow to help you quickly get
started to build a small demo system. You can also find the recommended flows of using Lattice Propel Builder in this
document.

1.2. Audience

The intended audience for this document includes embedded system designers and embedded software developers
using Lattice MachX03D, MachX03L, MachXO3LF, MachX02, LIFCL, LFD2NX, LFMNX, LFCPNX, and LFMXO5 devices. The
technical guidelines assume readers have expertise in the embedded system area and FPGA technologies.
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2. Lattice Propel Builder Design Flows

The Propel Builder design flow includes creating an SoC project design flow, and verification design flow, which are
discussed in detail in the following sections.

2.1. Builder Environment

After Propel 2.1 is installed, you can launch the stand-alone Propel Builder by double-clicking the Builder icon to launch
Builder. Refer to the Lattice Propel 2.1 Installation for Windows User Guide (FPGA-AN-02043) for details on the
installation. After the Propel Builder is launched, a single workbench window is displayed. The workbench contains
Menu, Toolbar, Design View, IP catalog, Schematic view, address mapping, Start Page and TCL console. Figure 2.1
shows the workbench with opening a project.

1. Menu bar

2. Toolbar

3. IP Catalog and Design View

4. Schematic View, Address Mapping, and Start Page
5. TCL Console

(% Propel Builder [C:/lscc/propel/2.1/workspace/HelloWorld/HelloWorlddelloWorld.sbx] Device: LIFCL-40-9BG400C Board: CrossLink-NX Evaluation - ] X

File Edit View Design Tools Window Help | |

W We 2 QQQQ 2

Schematic Address . Start Page
e ]
o r
1P on Local 1P on Server T
1 Meodule/IP on Local
~ Module

[ Architecture_Modules

» [ Arithmetic_Modules
b 7 Memory_Modules
+ [ Processors_Controllers_and_Peripherals
b [ Verification IP
A
» [ Processors_Controllers_and_Peripherals et et
» [0 Security_Subsystem -
s
s e
na
o e gt
- e 4 ]
o w01 e -
- = T
e s
T Ll e
— | s st
[ | g =50
N L P Moo+ |
s
rl equation split
}uus —D—
concat invert

i camlﬁ B
cl Console a

% sbp_design open -name HelloWorld -path {C:/lscc/propel/2.l/workspace/HelloWorld/HelloWorld/HelloWozld.sbx}
x

Figure 2.1. Propel Builder Workbench Window
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2.2. Project Design Flow
2.2.1. Creating a New SoC Project

1. Choose File > New Design from the Lattice Propel Builder Menu bar. The Create System Design — Design
Information wizard opens (Figure 2.2).

u.h

Design Information
Enter a name for your design and specify a directory where the design files wil be stored.

Project:

Type: SoC Project 7
Mame: EmptyProject

Location: | C:flsccfpropel/2. 1fworkspace * | | Browse...

Create Project at C: lsce/propel/2. 1fworkspace EmptyProject

Mext = Cancel

Figure 2.2. Create System Design — Design Information Wizard

2. The default Project Type is displayed in the Type field. Use the drop-down menu to choose SoC Verification if
creating a verification project.

3. Enter the desired project name in the Name filed.

4. (Optional) The default location is shown in the Location field. Use the Browse... option to change the project
workspace location.

5. Click Next. The Create System Design - Propel Project Configure wizard opens (Figure 2.3).
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4 Create System Design *
Configure Propel Project
Specify a device or board for project.
Language: Device Information:
: Part Number: LFCPMX-100-7ASG256C
Verilog
Logic Cells: 96000
Family: Board Processor: LUTs: 79872
LFCPNYX (CertusPro-hx) = | RISCWYMC Registers: 79872
EER Blocks: 208
Device: Templates:
: LRAM: 7
LFCPNX-100 = [NIERENED et DSP (1818 Multiplier): 156
Hello World Project
Package: ADC Blocks: 1
ASGI56 - PLLs: =+
DLLs: 2
Speed: PCSs: 2
7_High-Performance_1.0V - ALUs: 1
Operating Condition: DPHYs: 0
- PIO Cells: 299
Commercia PIO Pins: 193
Template Info:
Empty project for user to "build from scratch™,
< Back Mext = Cancel
Figure 2.3. Create System Design — Propel Project Configure Wizard
6. (Optional) The default Verilog is displayed in the Language field. Use the drop-down menu to change the default
language.
7. Specify a device or board for project.
e Use the drop-down menu to select desired device information (Family, Device, Package and Speed), and select
Empty Project in the Templates section (Figure 2.4).
© 2021 Lattice Semiconductor Corp. All Lattice trademarks, registered trademarks, patents, and disclaimers are as listed at www.latticesemi.com/legal.
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. Create System Design

Configure Propel Project
Specify a device or board for project.

Language: Device Information:
: Part Number: LFCPMX-100-7ASG256C
Verilog
Logic Cells: 96000
Family: Board Processor: LUTs: 79872
LFCPNYX (CertusPro-hx) = | RISCWYMC Registers: 79872
EBR Blocks: 208
Device: Templates:
: LRAM: 7
LFCPNX-100 = [NIERENED et DSP (1818 Multiplier): 156
Hello World Project
Package: ADC Blocks: 1
ASGI56 - PLLs: =+
DLLs: 2
Speed: PCSs: 2
7_High-Performance_1.0V - ALUs: i
Operating Condition: DPHYs: 0
: PIO Cells: 299
i -
Commercia PIO Pins: 193
Template Info:
Empty project for user to "build from scratch™,
< Back Mext = Cancel

Figure 2.4. Specify a Device for Project

e Click Board. The Propel Project Configure wizard is shown in the Board Select: area (Figure 2.5). Select the
desired board, such as Crosslink-NX Evaluation.

4. Create System Design

Configure Propel Project
Specify a device or board for project.

Language: Device Information:
Verilog Part Number: LFCPMX-100-9LFGE72C
Logic Cells: 96000
Board Select: Board | Processor: LUTs: 79872
E RISC-V MC Registers: 79872
CrossLink-MNX Evaluation - EBR Blocks: 208
MachX02 Breakout LRAM: 7
MachX03D Breakout EpptiBmiEcy DSP (1818 Multiplier): 156
MachX03D PFR Demo Helle World Project ADCHiodk: Q
PLLs: =+
DLLs: 2
PCSs: 2
AlUs: i
DPHYs: 0
PIO Cells: 299
PIO Pins: 359
Template Info:
Empty project for user to "build from scratch”™
< Back Mext = Cancel

Figure 2.5. Specify a Board for Project
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8.

9.
10.

Click Next. The Project Information wizard opens (Figure 2.6).

4., Create System Design

Project Information
Generate new project with the following spedifications.

Project:
Project Name: EmptyProject
Project Location: Ci/lscc/propel/2.1/workspace/EmptyProject
Language: Verilog
Device: LFCPMNX-100-9LFGET2C
Speed: 9_High-Performance_1.0V
Template Name: Empty Project

< Back Finish Cancel

Figure 2.6. Create System Design — Project Information Wizard

Check and confirm the project information.
Click Finish. Propel Builder GUI opens (Figure 2.7).

“. Propel Builder [C:/lscc/propel/2.1/workspace/EmptyProject/EmptyProject/EmptyProject.shx] Device: LFCPMX-100-9LFGE72C Board: CertusPro-NX Evaluation

File Edit View Design Tools Window Help

s@ R OC [“al=e g2 & = T QQQQ@

Design View | Schematic Addreszz Sy, Start Page
5 LFCPNX-100-9LFGET2C

EN EmptyProject
Compenents

clk_i
Properties
MName:; rstn_i
Type: Instance
Path: EmptyProject

VLNY: lattice:systembuilder :EEmptyProject: 1.0
File:  C:flscc/propel2. 1/workspace /EmptyProject/EmptyProject/EmptyProject. sbx

1P Catalog Design View 1

Tl Console

%

% sbp_design open -name EmptyProject -path {C:/lscc/propel/2.l/workspace/EmptyProject/EmptyProject/EmptyProject.sbx}

Figure 2.7. Propel Builder GUI Shows Empty Project

14
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2.2.2. Creating Template SoC Project

1. Choose File > New Design from the Lattice Propel Builder Menu bar. The Create System Design wizard opens
(Figure 2.8).

s, Create System Design >

Design Information
Enter a name for your design and specify a directory where the design files will be stored.

Project:

Type: SoC Project 7

Mame: HelloWarld

Location: | C:flscc/propel/2. 1fworkspace - | | Browse...

Create Project at C:lscc/propelf2. 1/workspace HelloWorld

Mext Cancel

Figure 2.8. Create System Design — Design Information Wizard

2. The default Project Type is displayed in the Type field. Use the drop-down menu to choose SoC Verification if
creating a verification project.

Enter a project name in the Name field, such as HelloWorld.

(Optional) The default location is shown in the Location field. Use the Browse... option to change the project
workspace location.

g

Click Next. The Propel Project Configure wizard opens (Figure 2.3).

6. Click Board. The Propel Project Configure wizard is shown in the Board Select area. Select a desired Board, such as
CertusPro-NX Evaluation.

7. Select a desired template from the Templates area, such as Hello World Project (Figure 2.9).

© 2021 Lattice Semiconductor Corp. All Lattice trademarks, registered trademarks, patents, and disclaimers are as listed at www.latticesemi.com/legal
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4. Create System Design X
Propel Project Configure
Specify a device or board for project.
Language: Device Information:
- Part Number: LFCPMNX-100-8LFGo72C
Verilog
Logic Cells: 96000
Board Select: Board Processor: LUTs: 79872
CertusPro-MNX Evaluation RISC-V MC Registers: 79872
CrossLink-MNX Evaluation Templates: EER. Blocks: 208
MachX02 Breakout e i— LRAM: 7
MachXO3D Breakout EI"I"Ipt_‘,' prOJECt Dsp (18)(18 Mulh’plier}l: 156
iHello World Project
MachX03D PFR Demo ellg ¥vorid Froje ADC Blodks: 1
PLLs: 4
DLLs: 2
PC3s: 2
AlUs: 1
DPHYs: a
PIO Cells: 299
PIO Pins: 308
Template Info:
Hello World Project. Components incuded:
a) Processor - RISC-V MC w/ PIC/TIMER
b) GPIO
c) ASRAM - Asynchronous SRAM
d_} UART - Serial port
< Back Next = Cancel
Figure 2.9. Specify a Board for Project
8. Click Next. The Project Information wizard opens (Figure 2.10).
%, Create System Design *
Project Information
Generate new project with the following spedfications.
Project:
Project Mame: HelloWorld
Project Location: C:/lscc/propel/2.1/workspace/HelloWorld
Language: Yerilog
Device: LFCPMNX-100-9LFGE72C
Speed: 9_High-Performance_1.0V
Template Mame: Hello World Project
< Back Finish Cancel

9. Check and confirm the project information.
10. Click Finish. Propel Builder GUI opens (Figure 2.11).

Figure 2.10. Project Information Wizard

© 2021 Lattice Semiconductor Corp. All Lattice trademarks, registered trademarks, patents, and disclaimers are as listed at www.latticesemi.com/legal.
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% Propel Builder [C:/lscc/propel/2.1/workspac bx] Device: LFCPNX-100-9LFG672C Board: CertusPro-NX Evaluation - [m} X

File Edit View Design Tools Window Help

sERA9CT A MBS BEDS @QQQ

Design View a Schematic Address 3 Startpage
I LFCPNX-100-SLFGET2C

~ 1F HelloWorld
= {% Instances
v {E ahbl0_inst
v i ahbl2apb0_inst
v IE apbOinst
v I cpulinst
+ IF equation_moduled_inst
v 1 gpioDinst
v 1F oscOinst
v LF plio_inst
b I sysmem0_inst
v 1E uartlinst
y 2 Ports
v Nets
» Components

Properties “ni b
Name: Q 0
Type: Instance § H
Path:  HelloWorld )
VLNV: lattice:systembuilder:HelloWWorld: 1.0
File:  Cxflscefor . lloWorldHellowarldjHelloworld.sbix
) 1P Catalog Design View ’ a C
Tel Console [m]
% sbp_design open -name HelloWorld -path {C:/lscc/propel/2.1/workspace/HelloWorld/HelloWorld/HelloWorld.sbx}
Figure 2.11. Propel Builder GUI shows Template Project
2.2.3. Opening an SoC Existing Project
S =
1. Choose File > “— Open Design from Propel Builder GUI Menu, or Click Open Design icon “— from Propel

Builder Toolbar. The Open sbx dialog opens (Figure 2.12).
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4. Open sbx *
0N » ThisPC » Windows (C:) » Iscc » propel » 2.1 » v O O Search 2.1
Organize » New folder = [ @
I This PC " Mame Date modified Type Size
“J 3D Objects builder 10/11/2021 1:33 PM File folder
I Deskiop data 10/11/2021 1:32 PM File folder
E] Documents doc 10/11/2021 1:32 PM File folder
N ispfpga 10/11/2021 1:32 PM File folder
; Downloads X X
libs 10/11/2021 1:32 PM File folder
D Music license 10/11/2021 1:33 PM File folder
= Pictures modeltech 10/11/2021 1:32 PM File folder
B videos pge 10/11/2021 1:33 PM File folder
=, Windows (C:) sdk 10/11/2021 1:33 PM File folder
DATAT (D7) templates 10/11/2021 1:33 PM File folder
tools 10/11/2021 1:33 PM File folder
& Network workspace 10/12/2021 9:55 A File folder
v
File name: v| Shx Files (*.sbx) ~

Figure 2.12. Open Sbx Dialog

2.  Browse to find the default project workspace folder or your own project workspace folder. Choose the sbx file,
such as HelloWorld.sbx (Figure 2.13).

4, Open shx *
<« M < propel » 2.1 » workspace » HelloWorld » HelloWorld » v O O Search HelloWorld
Organize « New folder =~ [ o
S
~ - -
I ThisPC Mame Date modified Type Size
) 3D Objects application 10/12/2021 File folder
[ Desktop a lib 10/12/202 M File folder
= | ] Helloworld.sbx 10/12/2021 %:57 AM SBX File 1412 KB
|Z] Documents
* Downloads
D Music
=/ Pictures
m Videos
i Windows (C:)
- DATAT (D)
. v
File name: |He||0W0rId.sbx v| Sbx Files (*.sbx) ~

Figure 2.13. Open HelloWorld Project

3. Click Open. The Builder GUI shows the SoC design.

Note: Choose File > Recent Designs from Propel Builder GUI Menu. You can quickly open a most recently closed
project.

2.2.4. Adding Modules

After starting a Propel Builder project, you can add modules by dragging them from the IP Catalog view to the
Schematic view. The IP Catalog view comes with a large variety of modules for common use and some glue logic
modules as well, which can be found from the IP on Local tab (Figure 2.14). Click the IP on Server tab to find and
download more modules for specialized use.
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1. (Optional) From the Propel Builder GUI IP Catalog area (Figure 2.14), choose the IP on Server tab. Select a desired

IP. Click the Install button. After the IP is installed successfully, the new IP can be shown in the IP on Local tab.

IP Cataleg -
sy

IP on Local IP on Server -
L1 module/IP on Local
* Module

» EI Architecture_Modules
» EI Arithmetic_Modules
» EI Mernory_Modules
» EI Processors_Controllers_and_Peripherals
¥ [ Verification IP
> [P

» EI Processors_Controllers_and_Peripherals

R
1E . f = aus-E
rtl equation split
}nus ~I>«-,—
concat invert
IP Catalog Design View

Figure 2.14. IP Catalog
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2. From the IP on Local tab, select a desired IP, such as GPIO. Double-click the IP module or drag and drop the IP
module to the Schematic view. A Module/IP Block wizard pops up (Figure 2.15).

% Module/IP Block Wizard X

Generate Component from Module gpio Version 1.6.0
This wizard will guide you through the configuration, generation and instantiation of this Module,/TP. Enter the following
information to get started.

Component name: | gpio0

Create in:

Next = Cancel

Figure 2.15. Module/IP Block Wizard — Generate Component from Module gpio Version 1.6.0

3. Enter a component name in the Component name area, such as gpio0. Click Next. Module/IP Block Wizard shows
the Configure Component from IP gpio Version 1.6.0 page (Figure 2.16).

4, Module/IP Block Wizard X

Configure Component from Module gpio Version 1.6.0
Set the following parameters to configure this component.

Diagram gpio0 Configure gpio0:
*| Property Value
~ General
Number of IO Lines [1 - 32] 1

Remaove Tri-5tate Buffer
Initial Qutput Value (hex) [0 - FFFFFFFF] |0

gpio0 10 Direction (hex) [0 - FFFFFFFF] 1

HAPB_SO

clk i

resetn i

Interface APB

INT

gpio_io[0:0]

gpio

1 b | Mo DRC issues are found.

< Back Generate Cancel

Figure 2.16. Module/IP Block Wizard - Configure Component from IP Gpio Version 1.6.0

4. (Optional) Click the Value field. You can enter a desired value for a property, check the checkbox to select a
property, or select a desired value from the dropdown menu for a property in the Value area. By changing the
value, the properties are thus configured. The property in gray is not configurable.

5. Click Generate. Module/IP Block wizard shows the Check Generated Result page (Figure 2.17).
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Hh

Module/IP Block Wizard

Check Generated Result

Check the generated component results in the panel below, Unchedk option 'Insert to project’ if you
do not want to add this component to your design.

Component ‘gpiol’ is successfully generated.
Module: gpio  Version: 1.6.0

Vendor: latticesemi.com

Language: Verilog

Generated files:

IP-XACT _component: companent, xml
IP-XACT_design: design.xml
black_box_werilog: rilfgpio0_hb.v

cfg: gpiod.cfg

IP package file: gpiol.ipx
template_verilog: misc/gpio0_tmpl. v
dependency_file: testbenchfdut_inst.v
dependency_file: testbench/dut_params.v
template_vhdl: misc/gpio0_tmpl. vhd
top_level_verilog: rilfgpio0.v

Insert to project

< Back Finish

Select Insert

Figure 2.17. Module/IP Block Wizard - Check Generated Result

to project (Figure 2.17) at the bottom of the Check Generate Result wizard.

Click Finish. The Define Instance dialog box opens (Figure 2.18).

4. Define Instance 7 *

Instance Mame: gpiod_inst
Instance Reference: gpiod;1.6.0

QK Cancel

Figure 2.18. Design Instance Dialog Box

(Optional) Change the instance name, if desired. Space and special characters are not allowed.

Click OK. The schematic block for the module appears in the Schematic view (Figure 2.19).
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4. Propel Builder [Ci/lscc/propel/2.1/werkspace/EmptyProject/EmptyProject/EmptyProject.sbx] Device: LFCPNX-100-9LFG672C Board: CertusPro-NX Evaluati..  — ml X
File Edit View Design Tools Window Help
= e =
cEH M A EEE LS Qe
IRiCatalog o Schematic Address & Start Page
o F
L] 4
TP on Local IP on Server T
I Module/IP on Local
¥ Module
3 Architecture_Maodules
3 Arithmetic_Madules
» Memary_Modules
- Processors_Controllers_and_Peripherals
& cPio 160 i00 inst
5 RISC-V MC 210 clk i I gpiod_ins I
5 RISC-V SM 110 - N
i} System_Memory 103
3 UART 130 tn i 71
Fb AHB Lite Interconnect 130 rstn_l r=-
% AHBLiteto APB Bridge 110 INTR|+| _—
Jik APB Interconnect 1.1.0 LE_
v [ Verification IP — clk_i
1 P
GPIO_IO
3 Processors_Controllers_and_Peripherals -
— resetn_i
] r
X J
{3 l = BUS-E J
rtl equation split
}BUS 7"/‘)7
concat invert
IP Catalog Design View . om
Tcl Conscle [m]
% sbp design open -name EmptyProject -path {C:/lscc/propel/2.l/workspace/EmptyProject/EmptyProject/EmptyProject.sbx}
% sbp_design config ip -vlnv {latticesemi.com:ip:gpio0:1.6.0} -meta_loc {C:/lscc/propel/2.1/builder/rti/ip/common/gpio} -cfg
{C:/lscc/propel/2.1/workspace/EmptyProject/EmptyProject/.lib/latticesemi.com/ip/gpic0/1.6.0/gpio0.cEg}
% sbp_add component -vinv {latticesemi.com:ip:gpic0:1.6.0} -name {gpiod_inst}
%

Figure 2.19. Propel Builder Schematic View Shows the Module Instance

2.2.5. Adding Glue Logic

Propel 2.1 builder supports glue logic modules as well as IP modules. You can add glue logic modules by dragging them
from the IP Catalog view (Figure 2.20) to the Schematic view.
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IP Catalog O
o ox

IP on Local IP on Server -
1 Module/IP on Local
* Module

k ||f'| Architecture_Modules
» EI Arithmetic_Modules
k ||f'| Mernory_Modules
» EI Processors_Controllers_and_Peripherals
¥ [ Verification IP
> [P

b ||f'| Processors_Controllers_and_Peripherals

e
1 F f = aus-E
rtl equation split
}nus ~I>«-,—
concat invert
IP Catalog Design View

Figure 2.20. IP Catalog

e Concat

a. From the IP Catalog, select the concat module. Double-click the concat module or drag and drop concat
module to the Schematic view. A Glue Logic wizard (Figure 2.21) pops up.
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&
Logic Diagram Configuration
i RHS: | BUS[S:0]
LHS: | alsiq)
Bl3:1]
AL5:4] -

B[3:1]|BUS[5:0]
crol.

QK Cancel
Figure 2.21. Glue Logic for Concat Module

b. Click the RHS field to change the default right-hand side bus width to a desired one. Click the LHS field to

change the default left-hand side bus width to a desired one. Click the Add button to add LHS (Left-

hand Side). Click the Remave button to remove LHS (Left-hand Side). You can only add or remove LHS but
not RHS. LHS and RHS are thus configured.

c. Click OK. The schematic block for the concat module in red appears in the Schematic view (Figure 2.22).

Schematic Address Sy, Start Page

clk_i > A[w
rstn i > B[3:1]] BUS[5:0]

Figure 2.22. Schematic View Shows a Concat Module

Equation

a. From the IP Catalog, select the equation module. Double-click the equation module, or drag and drop the
equation module to the Schematic view. A Glue Logic wizard (Figure 2.23) pops up.
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%, Glue Logic ? X

Logic Diagram Configuration

H Module Name: = equation_module

Expression: O= 1A &IB

equation_module
0

AT AP

oK Cancel

Figure 2.23. Glue Logic Wizard for Equation Module
b. Click the Module Name field to change the default value to a desired name. Click the Expression field to

change the default expression to a desired one. The expression supports and (&), or (|), negation (!). The
module name and expression are thus configured.

c. Click OK. The schematic block for the equation module in red appears in the Schematic view (Figure 2.24).

Schematic Address 4y, Start Page

equation_module_inst

\e
-

é:p

ém

Figure 2.24. Schematic View Shows an Equation Module

e |nvert

a. From the IP Catalog, select the invert module. Double-click the invert module, or drag and drop invert module
to the Schematic view. The schematic block for the invert module in red appears in the Schematic view
(Figure 2.25).
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Schematic Address 4, Start Page

invert

Figure 2.25. Schematic View Shows the Invert Module

e Rtl

a. From the IP Catalog, select the rtl module. Double-click the rtl module or drag and drop the rtl module to the
Schematic view. A Glue Logic wizard (Figure 2.26) pops up.

., Glue Logic ? X

Logic Diagram Configuration

Use Existing File:

Ri:  module ri_module {input rstn,output out);
endmodule

rtl_module

—rstn out—

oK Cancel

Figure 2.26. Glue Logic Wizard for Rtl Module

b. You can edit your own rtl module in the Rtl area by entering the rtl module function.
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c. Or, you can use an existing rtl module by checking the Use Existing File checkbox. After checking the Use
Existing File checkbox (Figure 2.27), browse to find the existing RTL module file path from the Path filed. And,

check the CopyToDesign checkbox, if you want to copy the rtl module to the design.

4. Glue Logic
Logic Diagram Configuration
Use Existing File:
Path: rkspace/test_modulel.v
CopyTaoDesign:
nv
A[2:0]}
—|bb[10:8] Bl
4 3
Ok

*

Cancel

Figure 2.27. Existing Rtl Module Configuration

d. Click OK. The schematic block for the rtl module in red appears in the Schematic view (Figure 2.28).

Schematic Address Ay, Start Page
inv_inst
A[Z:O] —
==l bb[10:8] Bp=—
C

Figure 2.28. Schematic View Shows the Custom Rtl Module

Note: Currently, Rtl Module only supports Verilog HDL.
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e Split
a. From the IP Catalog, select the split module. Double-click the split module, or drag and drop the split module
to the Schematic view. A Glue Logic wizard (Figure 2.29) pops up.

%
Logic Diagram Configuration
i LHS: | BUS[5:0]
RAS: | alsiq)
B[3:1]
C[o]
A[5:4]
Add Remove
BUS[5:0]|B[3:1]
C[0]
4 3 i
| OK Cancel |

Figure 2.29. Glue Logic Wizard for Split Module

b. Click LHS field to change the default left-hand side bus widths to a desired one. Click RHS field to change the

default right-hand side bit width to a desired one. Click the Add button to add an RHS. Click the
Remave button to remove an RHS. You can only add or remove RHS but not LHS. LHS and RHS are thus
configured.

c. Click OK. The schematic block for the split module in red appears in the Schematic view (Figure 2.30).

Schematic Address . Start Page

A[5:4]

BUS[5:0]] B[3:1]

c[o]
m

Figure 2.30. Schematic View Shows Split Module
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2.2.6. Undo/Redo

Propel 2.1 Builder supports one-level undo/redo. You can click the Undo icon from Propel Builder Toolbar to go back to
last action. Click the Redo icon from Propel Builder Toolbar to recover last undo action.

I:E:_'_:\__ I:E:_'_:\__
1 I]
e Undo:Choose Edit> “ Undo from the Lattice Propel Builder Menu bar. Or, click the Undo icon  “ from

Propel Builder GUI Toolbar.
e Redo: Choose Edit> Redo from the Lattice Propel Builder Menu bar. Or, click the Redo icon b from
Propel Builder Toolbar.

Note: Currently, Propel 2.1 Builder only supports single undo/redo.

2.2.7. Modifying the Project Settings

Propel 2.1 Builder supports changing the projects settings. You can modify the device, package, speed and operating
conditions by double clicking the device part number from the Design View.

1. Double click the device part number from the Design View (Figure 2.31), the Modify Device Info wizard pops up.
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Design View O
‘ LFCPMX-100-9LFGE7T2C
+ 1E HelloWeorld
r EIEF Instances
v 1F ahbl0_inst
v 1 ahbl2apb0_inst
v 1F apb(_inst
v 1 cpullinst
k E equation_rmodulel_inst
N gpic0_inst
k E oscl_inst
v 1F pli0inst
k E sysrmeml_inst
» ﬂ uartl_inst
k EC' Ports
3 rE Mets
3 Components
Properties
Mame: | cpul_inst
Type: Instance
Path: HelloWorld/cpul_inst
VLMY:  latticesemi.com:ip:cpul:2. 1.0
IP Catalog Design View
Figure 2.31 Design View of Device Part Number
2. Use the drop-down menu to choose the desired device in Device filed in the Modify Device Info wizard

(Figure 2.32). Use the drop-down menu to change the package, speed and operating condition in Package, Speed,
Operating Condition filed.

30
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<., Modify Device Info: ? it
Family: Device Information:
Part Mumber: LFCPMX-100-7CBG 2561
T Logic Cells: 6000
Device: e o572
LFCPMX-100 - Registers: 79372
Package: EBR Blocks: 208
LRAM: 7
CBG236 M DSP (18x18 Multiplier): 156
Speed: ADC Blocks: 1
7_High-Performance_1.0v - PLLs: 4
DlLLs: 2
Operating Condition: — 5
Industrial - ALLs: 1
DPHYs: i]
PIO Cells: 299
PIO Pins: 183
Ok Cancel

Figure 2.32 Modify Device Info

3.  Click OK. The System Builder dialog (Figure 2.33) pops up to show the warning message about configuring all IPs.

W, Systern Builder >
This cperation needs to configure all [Ps in the current project.

Do you want to do this?

fes Mo

Figure 2.33 System Builder Dialog

4. Click Yes to configure all IPs in current project. The new device partnumber shows in Design View (Figure 2.34).
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DesignMisw
8| LFCPNX-100-7CBG256!
+ 1 HelloWorld

-

3
4

1? Instances

3 ﬂ equation_modulel_inst
» 1F ahbl0_inst

v 1 ahbl2apb0_inst
3 ﬂ apbl_inst

3 ﬂ cpul_inst

v 1 gpioD_inst

3 ﬂ oscl_inst

» 1E pli0_inst

3 ﬂ sysmem{_inst
3 ﬂ uartl_inst

2 Ports

.ENets

» |£¥ Components

Properties

Mame:

Type:
Fath:
WLNV:

uartd_inst

Instance
HelloWorld juartd_inst

latticesemi.com:ip:uart0: 1.3.0

IP Catalog Design View

Figure 2.34 Design View of Device Partnumber

2.2.8. Working with the Schematic View

You can make changes in the Schematic view including automatic layout to clean up the display, moving, resizing,
renaming blocks manually, highlighting objects and zooming the display in and out.

e Toview signal list of block:
.
Click the plus signL.= of the desired block to see what signals it contains. The plus sign changes to a negative sign
r= r=1
| — | . - . . . N . | s |
L-4 and shows the signal list as shown in Figure 2.35. Click the negative signL-4 to close the expanded bus. The
schematic returns to the previous form.
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e To select one or more objects:

gpio0_inst

p

i—iAPB_S0
»PADDR[5:0]
»PENABLE
«PRDATA[31:0]
«PREADY
P PSELx
«PSLVERR
»PWDATA[31:0]
»PWRITE

clk_i

resetn_ij

rya
INTRi=i =

gpio_iol—

Figure 2.35. Signal List of Modules

Select one object or more objects in one of the following ways:

e  Click on the object in the Schematic view. The selected object turns to red (Figure 2.36).
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4. Propel Builder [C:/flscc/propel/2.1/workspace/EmptyProject/EmptyProject/EmptyProject.sbx] Device: LFCPNX-100-9LFGE72C Board: CertusPro-NX Evaluation

File Edit View Design Tools Window Help
sl M A RO E YO H-e o QQaQa@
IP Catalog m] Schematic Address Ay, Start Page
cE
1P on Local IP on Server T
I Module/IP on Local
* Module
» Architecture_Modules
3 Arithmetic_Modules
3 Memony_Modules
- Processors_Controllers_and_Peripherals
= GPIO 160
& RISC-V MC 210 ok | gpio0_inst
T RISC-V SM 110 - (f \
i System_Memory 103
& UART 1.3.0 r=-
& AHB Lite Interconnect 130 rstn_i > — |+|AF‘B_SD
f% AHB Lite to APB Bridge 110 | L | ry-
5 APE Interconnect 1.1.0 INTR|+| -
v [ Verification IP L=
- w— CIK
¥ Processors_Controllers_and_Peripherals
e resetn_i

T 1 o L

rtl equation split concat invert
Design View IP Catalog ‘
Tel Console

.1/workspace/EmptyProject/EmptyProject/.lib/latticeseni.com/ip/gpiod/1.6.0/gpic0. cEg}
sbp_add component -vlnv {latticesemi.com:ip:gpic0d:1.6.0} -name {gpio0_inst}

% sbp_design open -name EmptyProject -path {C:/lscc/propel/2.l/workspace/EmptyProject/EmptyProject/EmptyProject.sbx}

% sbp_design config ip -vlnv {latticesemi.com:ip:gpic0:1.6.0} -meta loc {C:/lscc/propel/2.1l/builder/rtf/ip/common/gpio} -cfg {C:/lscc/propel/
2

%

Figure 2.36. Select Object

e  Ctrl-click or Shift-click in the Schematic view to select more than one objects.

e Click the Area_select icon L from the Propel Builder Toolbar. Click and drag to draw a selection rectangle
around the modules and ports in the Schematic view. Click the icon again to turn off the Area_select mode.

e  From the Schematic view, Right-click and choose Select All or press Ctrl-A to select all the objects.

Note: Ctrl-click or Shift-click on the object in the Schematic view can also de-select the object while leaving the

others selected.

e Tore-arrange the schematic:

Propel Builder allows re-arranging the objects in the schematic view. You can re-arrange modules and the ports.
Drag objects to re-arrange the schematic. Propel Builder has rules for placing objects to adjust the schematic in an

organized arrangement.

a. Select the desired modules (one or more modules can be dragged at the same time) or ports (one or more

ports can be dragged at the same time).
b. Click on the selected items and drag it to the desired location.

c. Release the mouse button.

Note: The selected objects can be moved to the specified location, or as near as the rules allow. Other objects in

the schematic can also be moved to accommodate the selected objects’ new location.
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To bring selected objects to the center of the Schematic view using the Locate Object mode:

a. Click the Locate Object icon €7 from the Propel Builder Toolbar. The background turns to dark gray.
b. Select the object in the List view of the Design View. The selected object is in the center of the Schematic View

(Figure 2.37).

4. Propel Builder [C:/lscc/propel/2.1/workspace/EmptyProject/EmptyProject/EmptyProject.sbx] Device: LFCPNX-100-9LFGE72C Board: CertusPro-NX Evaluation — m] s
File Edit View Design Tools Window Help
= e o
s A M ( X a8 @ T QQaa@
Design View m] Schematic Address Ay, Start Page
I} LFCPNX-100-9LFGET2C 7
- 1} EmptyProject
» gc' Ports
- ﬁ Instances
3 i:E gpiol_inst
3 Components
) gpio0_inst
clk_i > I ’ ~
: ryga
rstn_i - |+|APELSO
L=d rg
INTR|+| j—
_ LI
— Clkﬁ\
gpio_[o —
w—l resetn_i
Properties
Name: gpio0_inst
Type: Instance
Path: EmptyProjectfgpiod_inst
WLNV:  latticesemi.com:ip:gpiod: 1.6.0
Design View IP Catalog ‘ S =
Tel Console m]
% sbp design open -name EmptyProject -path {C:/lscc/propel/2.l/workspace/EmptyProject/EmptyProject/EmptyProject.sbx} =
% sbp_design config ip -vlnv {latticesemi.com:ip:gpio0:1.6.0} -meta loc {C:/lscc/propel/Z.l/builder/rtf/ip/common/gpio} -cfg {C:/lscc/propel/
2.1/workspace/EmptyProject/EmptyProject/.lib/latticesemi.com/ip/gpio0/1.6.0/gpio0.cfg}
% sbp_add_component -vlnv {latticesemi.com:ipigpio0:1.6.0} -name {gpic0_inst}
-

Figure 2.37. Locate Objects

To automatically simplify the layout:
Right-click anywhere in the Schematic view and choose Relayout.

To duplicate a module:

e Select the desired module and click Clone . Or, right-click on the module and choose Clone . A copy of
the schematic block appears with a new instance name (Figure 2.38).
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gpio0_inst gpio0_inst_0
' ™ ' ™
= ig=iAPB_SO _ = i1 APB_SO _
B INTR o] e N INTR{ofe] [
—clk_i B —clk_i B
gpio_io— gpio_iol—
—resetn_i —{resetn_i
. J . J

Figure 2.38. Duplicate a Module

To restore a deleted module:

a. Inthe List view of the Design View (Figure 2.39), go to the Components folder. The deleted module can still be
found in the List view in plain text. Those not deleted are shown in bold-faced text.
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Design View O
a LFCPMX-100-9LFGET2C
+ 1 EmptyProject
¥ g‘: Ports
- EE—FF Instances
r 1F gpic0_inst
3 E gpicl_inst_0
hd Components

|| gpio0:1.6.0
|| gpio0_0:1.6.0

Properties
Mame:

Type: Instance

Path: EmptyProject

VLMY: lattice:systembuilder:EmptyProject: 1.0

File:  C:flscc/propel/Z. 1jworkspace EmptyProject/EmptyProject/EmptyProject.shx

Design View IF Catalog

Figure 2.39. Design View

b. Right-click on the desired component and choose Instantiate. The Define Instance dialog box (Figure 2.40)
open.
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%, Define Instance ? >
Instance Mame: apbd_inst
Instance Reference: apb:1.1.0

Ok Cancel

Figure 2.40. Define Instance Dialog Box

c. Enter a name for the new instance.

d. Click OK. The module appears in the Schematic view and the List view of Design Info, and the component
name is bold-faced.

e Toreconfigure a module:

a. Double-click the module, or right-click the module. Choose Reconfig. The Module/IP Block wizard (Figure 2.41)
opens.

4., Module/IP Block Wizard X

Configure Component from Module apb_interconnect Version 1.1.0
Set the following parameters to configure this compaonent.

Diagram apb0 Configure IP
General Main Settings Master Priority Settings
Property Yalue
~ General
Total APB Masters [1 - 32] 2
Total APB Slaves [1- 32] 2
Master Address Width(bits) 32
apb0
Data Bus Width(bits) 32
—(4HAPB_s00
—HaPB_s01  APB_MOOH
—apb_pclk_i APB_MO 1/ (=
—apb_presetn_i

apb _interconnect

1 > Mo DR.C issues are found.

Generate Cancel

Figure 2.41. Module/IP Block Wizard — Configure Component

b. Configure component (including General property, Main Settings and Mater Priority Settings) at Configure IP
table in the Module/IP Block Wizard. Click Generate to generate the module as usual. The schematic block for
the module changes to match the new configuration.
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Note: For an SoC design, if the init file (mem file) of System Memory module instance is updated in a C project, the
initialization section of the system memory module instance should be re-configured. Or, use the ECO flow to
update the information. Refer to the Diamond online help for more on how to use an ECO flow.

e Toresize module blocks:
a. Select the desired module block. The block is highlighted in red with black corners (Figure 2.42).

l— apb0_inst _l
=1 IAPB_S00
— EﬂAPB_SDI APB_MDD[E j—
—apb_pclk_i APB_MO1 {3} =

—lapb_presetn_i
IS -

Figure 2.42. Select Module

b. Click and drag one of the corners to change the size and shape of the block.
c. Release the mouse button. All the other objects move to make room for this block.
Note: Right-click the module block and choose Unresize Instance to restore the size of the module block.

e There are a variety of methods to zoom within the Schematic view, including toolbar commands and dragging in
the Schematic view.

The following commands are available from the Propel Builder Toolbar.
e Zoom In (Ctrl++) @ — enlarges the view of the entire layout.
e Zoom Out (Ctrl+-) Q — reduces the view of the entire layout.

e Zoom Fit — reduces or enlarges the entire layout so that it fits inside the window.
l/b\
e ZoomTo A _ enlarges the size of one or more selected objects on the layout and fills the window with

selection.

Note: The mouse wheel provides a finer zoom control by rolling the mouse wheel forward to zoom in and
backward to zoom out while pressing the Ctrl key.

To zoom by holding the mouse button and dragging.
e To zoom to fit the window, drag up and to the left. The image adjusts to fill the window.

e Tozoom out, drag up and to the right. The dragging distance determines the amount of zoom. The image is
reduced and centered in the window.

e Tozoom in, drag down and to the left. The dragging distance determines the amount of zoom. The image is
enlarged and centered in the window.

e« Tozoomin in a specific area, start at the upper-left corner of the area and drag to the lower-right corner of the
area. The area that dragging across is adjusted to fill the window.

Note: Make sure that the Area_select icon k is not selected in the Toolbar. If you need to use Area_select and
zoom by dragging frequently, choose Design > Options from Propel Builder menu bar. The Options Dialog opens
(Figure 2.43). Select Use right mouse button for zooming actions and click OK. Then you can select an instance
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using the left mouse button, zoom in or zoom out using the right mouse button, and the Area_select icon L
disappears from the Propel Builder Toolbar.

4. Options ? x
Themes: Light -
General Color Metwork Settings Directories

Use right mouse button for zooming actions

Set Default

K Cancel Apply

Figure 2.43. Options Dialog

To move the schematic image within the Schematic view by panning and scrolling.

e To pan the image: Hold down the Ctrl key and the left mouse button while dragging the image.

e To scroll vertically: Rotate the mouse wheel. Or, click in the vertical scroll bar.

e To scroll horizontally: Hold down the Shift key and rotate the mouse wheel. Or, click in the horizontal scroll bar.

To show the connectivity of a module: right-click the module and choose Show connectivity. All nets connected to
the module, all pins and ports connected to the nets are highlighted (Figure 2.44).

40
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% Propel Builder [C:/Iscc/propel/2.1/workspac bx] Device: LFCPNX-100-9LFG672C Board: CertusPro-NX Evaluation - O X

File Edit View Design Tools Window Help

s &= DT RMEErEUMRNE @QQ Q@

DomVica] o Schematic Address S start Page
I LFCPNX-100-9LFGE72C
+ 1 HelloWorld
+ ¥ Instances
» 1F ahbloinst
» I ahbl2apb0_inst
» I apblinst
vk cpullinst
» I equation_moduled_inst
» IF gpio0_inst
» 1T osel_inst
v I1 plioinst
» I sysmem0inst sysmennd st
v 1} vart0 inst L
» 3= ports .
b Mets
» [#] Components L 0 e [ — L - £
n . - pr—— o
1 S i e amie Ny __I" o )
- Mgt Lo ]
Lo
L [ l | ) ; "
I e
L D |
Properties
Name:  cpuO_inst 9

Type: Instance
Path:  HelloWorid/cpud_inst
VLNV: Iatticesemi.com:ip:cpu:2. 1.0

1P Catalog Design View a

Tel Console
sbp_design open -name HelloWorld -path {C:/lscc/propel/z.1/workspace/HelloWorld/HelloWorld/HelloWorld.sbx}
B

Figure 2.44. Show Connectivity of the Module

<,
e To highlight an object: select an object and click Highlight ‘é, or, right-click the object and choose Highlight

2 2
. The object is highlighted in blue (Figure 2.45). Click Highlight again. You can remove highlighting.

gpio0_inst

Figure 2.45. Highlight an Object

e To change the name of an object:

a. Select the object from the List view of Design View. Information of the selected object is shown in the
Properties area (Figure 2.46).
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Properties

Mame: | gpiol_inst

Type: Instance
Path: HelloWorld/gpio0_inst
VLMY:  latticesemi.com:ip:gpiod: 1.6.0

Figure 2.46. Object Properties

b. Change the name and click Enter. The name changes in the Schematic view and List view of Design Info.
e To print a schematic:
a. Choose File > Print Preview. The Print Preview window (Figure 2.47) opens.

14, Print Preview: Schematic 7 'Y

wn Q& BE 4¢ n»d»> JHE D&

Figure 2.47. Print Preview

b. Expand the Print Preview window to the desired size.

c. Click the Page Setup buttonEE."j and adjust the paper size and margins, if necessary.

d. Click the Print buttong .
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e. Adjust the printer settings, if necessary. Click Print.

2.2.9. Connecting Modules

You can connect the pins of modules to other modules or to top-level ports by dragging a line between them or by
selecting connection points, or by assigning a constant value to an input pin or bus. Propel Builder does not allow
obvious inappropriate connections, such as a connection between two output pins or mismatched buses.

e To connect modules by drawing:

a. Move the cursor to a pin or port. The cursor changes to a pencil icon 1#. Click and hold while dragging to
another pin, port, or net. An allowed pin or port shows a green check-mark when you hover over it
(Figure 2.48). An allowed net becomes bold when you hover over it (Figure 2.49).

apb0_inst
e P _ ~\ gpic0_inst
—{ [ =1 APB_S00 w/ =
L=J i) I i=jmi APB_SO S
— Ir-I-I APB_S01 APB_MO0L+_= L= INTRL+_=
S . clk_i -
e APB_MO1 ] fomem io_io
. - '-!-' resetn i 9Pl
—apb_presetn_i
h

S

Figure 2.48. Draw a Pin or a Port

. sysmemO_inst
cpu0_inst o
( & ri
AHBL_SO
~ FFIRQ_S0 L?" -
:_;IRQ_SI — FHAHBL_S1
— -1
b —{ahbl_hdlk_i
—FRIRQ_S2 _
- — ahbl_hresetn_i
={i++IRQ_S3AHBL_MO_INSTRi4-i =

-
— IRQ_S4 AHBL_M1_DATALF} =

—~{FHIRQ_S5 TIMER TRQ_MOFF]
—HIRQ.S6 e system_resetn_of—
_—FHIRQ_S7
clk_i a—y
rstn_i m rst_n_i

. v

Figure 2.49. Draw Nets

b. Click on the pin, port, or net that you want to connect to. If the connection is allowed, a line appears
connecting the two objects. Propel Builder creates a path around other objects.

c. You can connect multiple ports once. When more than one port are selected (Figure 2.50), click connect
from the right-click menu to implement it.
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hbizapbo_inst
shblo_inst L
FF AHBL_SO —
w5 HFAHBL_S00 . R — b2
red_i[ o “hb bl s AHEL_MOOGE i APB_MOZE — led_o[7:0]
o e, | AHEL MOLEF £_n_
apbl_inst
cho inst FFM)B_mAPB Moo
apb_pclk i =
HFIRQ_SEBBL_MO_INSTRAF ... APB_MOLEF
FFIRG_SHEL M1 DATATF T
ki TIMER_IRQ_MOHF =
—frst_n_i Ty 0
oscl_inst

gpicd_inst

zhbl_hresatn_

uartl_inst

FAPE_S0
ki INT_MORF
st n o

Figure 2.50. Select More than One Ports

d. When the net is complete, right-click to leave the drawing mode.
e To connect modules by selecting points:

a. Select the pins, ports, and nets that you want to connect.

o—

]

b. Right-click one of the selected objects. Choose Connect — .
e To assign a constant value to an input pin:

a. Select the desired pin and right-click the pin. Choose Assign Constant Value (Figure 2.51). A small dialog box
appears (Figure 2.52).
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sysmemO_inst

r

ua * Highlight

rst n_i

ahbl

1%

ahbl_

r
L'l'__}‘ﬁlPE_E = Connect

~———{ FIAHBL_S0
= IHAHBL_S1

b inm ot

Copy Full Path

Assign Constant Value

[+ Export
Create Port
Auto connect clk rst
Create Comment

5 Validate Design

Select All
Relayout

Figure 2.51. Action Menu of Right-clicking an Input Pin

sysmem_inst

MRAHBL_S0
MRAHBL_S1

ahbl_hclk

___Assign constant value:

ob v X

Figure 2.52. Dialog Box of Assigning Constant Value to an Input Pin

b. Enter the desired value. To erase the value and start over, click X. For all buses (more than one pin), the
format is hexadecimal. Make sure the value fits the number of pins in the bus. For example, a 3-pin bus can

accept 0-7, but not 8.

Usually, disconnecting modules just means deleting a net. If the net has multiple branches, just delete one branch,

leaving the rest of the nets intact.

e Todisconnect one branch of a net, right-click the pin of that branch and choose ~ Disconnect. The branch

going to that pin disappears.

e To disconnect a whole net, right-click the net and choose Delete. The whole net is deleted.
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2.2.10.Creating Top-Level Ports
With multiple modules in a Propel Builder project, top-level ports need to be created for a complete Propel Builder
module. You can create a top-level port either manually or automatically.
For input ports that connect to more than one pin, such as for clock and reset signals, the manual way is more
convenient than the automatic way. If the port names automatically-generated need to be changed, the manual way is
better.
For other pins, the automatic way is usually preferred. The automatic way enables you to create the appropriate port
type and connect net simultaneously. The automatic way can also create multiple ports at the same time.
The automatic way of creating ports is the most effective. If all the modules are selected, Propel Builder can
automatically create ports for all the remaining unconnected pins for selected modules in one step.
e To create a port for a pin or bus manually:

a. Right-click in the Schematic view, and choose Create Port. The Create Port dialog box pops up (Figure 2.53).

%, Create Port ? >
Mame: input_paort
Direction: Input 7
Type: General -
Bus Options:

Ok Cancel

Figure 2.53. Create Port Dialog Box

b. Enter a name for the port in the Name field.
Choose a direction for the port, such as Input in the Direction field.
d. Choose the port type from the Type field. The default type is General.

e. (Optional) Select the Bus Options. Enter the number for the most significant bit (MSB) and the least significant
bit (LSB). These two options define the bus width.

f.  Click OK. The port appears. Figure 2.54 shows an input port, port name of which is on the left. Figure 2.55
shows an output port and an inout port, port names of which are on the right.

input_port [ >

Figure 2.54. Input Port

{_> Inout_port
[ output_port

Figure 2.55. Output Port and Inout Port

g. Connect the port to the module pins. Refer to the Connecting Modules section for more details.
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e Tocreate ports automatically:

a. Select the pins that are to be connected to the top-level ports. All the pins in a module can be selected by
clicking its block. Any pins that are already connected to a net or a constant value are skipped.

b. Right-click on one of the selected pins, interfaces or modules, and choose B"Export. The selected pins are
extended by lines to new top-level port symbols. The names of the ports and nets are added to the List view.
Zoom out or scroll the image in the Schematic view to see the new ports.

c. Portor net names can be changed, if needed.

2.2.11. Adjusting Address Spaces

The Address view shows the base address, size of the address segment, and the end address for each leaf
memory-mapped slave connection in the Propel Builder project. Propel Builder can automatically assign address
values, while the base address value can be changed manually. The ranges are set when the modules are configured.
The end addresses are calculated.

The Lock option on each address space prevents Auto Assign from changing the base address value. The Lock option is
selected automatically when you manually change the address value. To reset the address space, clear the Lock option
before clicking the Auto Assign icon.

Note: There is no Lock option on LocalMemory. The value of the base address can always be changed, while Auto
Assign does not reset it to its original value.

1. Inthe Propel Builder main window, click the Address tab. The Address view (Figure 2.56) shows.

Schematic Address . Start Page
Cell Base Address Range End Address  Lock
~ cpul_inst 0x00000000
~ LocalMemory
cpul_inst/pic_timer_registers 0xFFFFO000 2K OxFFFFOTFF

~ cpul_inst/AHEL_MO_INSTR(32 address bits: 4G)

sysmem(_inst/AHBL_S0 0x00000000 32K 0x00007FFF
~ cpul_inst/AHEL_M1_DATA(32 address bits: 4G) 0x00007FFF
000008000

gpiol_inst/APB_S0 0x00008400 1K 0x000087FF [

sysmem(_inst/AHBL_S1 000000000 32K 0x0000TFFF [
uart0_inst/APB_S0 000008000 1K 0x000083FF [ 0x000083FF

0x00003400

gpio0_inst/APB_S0

0x000087FF

4 L4

Figure 2.56. Address View

2. (Optional) Set or clear the Lock options as desired in Address view.
3. Inthe Propel Builder Toolbar, click Auto Assign m . Default address values appear in Address view.
4. (Optional) Double-click the base address in Address view (Figure 2.57). Type the new value and press Enter. Values

must align with 1K boundaries, such as 0x00000400, 0x00000800, or 0x00000C00. The end address value changes
based on the new value. The Lock option is selected automatically at this time.
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Schematic Address . Start Page
Cell Base Address Range End Address  Lock
~ cpul_inst
™ LocalMemory OxFFFFO000
«cpul_inst/pic_timer_registers 2K OxFFFFOTFF
v cpul_inst/AHBL_MUO_INSTR(32 address bits: 4G)
sysmem(_inst/AHBL_S0 000000000 32K 0x00007FFF [
~ cpul_inst/AHBL_M1_DATA(32 address bits: 4G)
gpio0_inst/APB_S0O 0x00008400 1K 0x000087FF [
sysmem(_inst/AHBL_S1 0x00000000 32K 0x00007FFF [
uart0_inst/APB_SO 0x00008000 1K 0x000083FF [
OxFFFFO7FF
4 3

Figure 2.57. Edit Base Address

Note: If there is a conflict of a related address space, it is shown in red in the graphic.

2.2.12.Validating the Design
The design rule check (DRC) can be run at any time. This checks whether or not there is any illegal connection or
overlapping address space.

To perform the design rule check:

1. From the toolbar of the Propel Builder main window, click the Validate Design icon @ . The DRC results appear in
the Tcl Console.

2.2.13.Generating the RTL file

The final step for creating a Propel Builder module is to generate a .sbx file, which defines a Propel Builder project, an
RTL file, and the instantiation templates. The RTL file includes the Verilog code for the module. The instantiation
templates have Verilog and VHDL code to help instantiate the Propel Builder module in a design.

|.-' -
e  From the toolbar of the Propel Builder main window, click the Generate icon ';"4 . This step also saves the Propel

Builder design and runs the design rules check (DRC).

e  From the toolbar of the Propel Builder main window, click the Generate Memory Report icon E . The SoC
design memory information is generated. The memory report folder (mem_report) is generated. All design
memory information is shown in detail in the memory report files. The Memory Report files are in HTML format

(Figure 2.58).

SOC Memory Map for S0C : Project Summary Page

HelloWorld Generated by Lattice Propel Software SOC Verification Engine
Copyright (C) 1992-2021 Lattice Semiconductor Corporation. All Rights Reserved.
Table of Contents

Project Summary

Project Name Family Device PartName Speed Language
9 High-
HelloWorld LFCPNX LFCPNX-100 LFCPNX-100-9LFGE72C | — :g [verilog
Performance 1.0V

Figure 2.58. Memory Report
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2.2.14.Opening Project in Diamond or Radiant

In a complete SoC project, a Diamond or Radiant project can be created including a Propel Builder design, and after
that the SoC project can be opened in Diamond or Radiant software. According to device in the SoC project, Propel
Builder can launch Diamond or Radiant software accordingly. If the device is LCMX0O3D, MachXO3L, MachXO3LF,

*

MachX02, LFMNX, the Diamond icon

and LFMXO5, the Radiant icon

is shown in the Builder GUI Toolbar. If the device is LIFCL, LFD2NX, LFCPNX,

Diamond or Radiant software directly after template SoC project is created.

e Tolaunch Diamond software:

a. Click the Diamond icon

from the Propel Builder toolbar.

is shown in the Builder GUI Toolbar. For a template SoC project, you can launch

b. Lattice Diamond is launched with a Diamond project generated for SoC at background (Figure 2.59).

# Lattice Diamond - Start Page
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Output Error Warning® Info*

Ready

Mem Usage: 170,660 K

Figure 2.59. Diamond Project

c. (Optional) From the File List view of Diamond:
+« modify the top-level RTL file (<proj_name>_Top.v) to match the SoC design, presupposition of which is
that there is a top-level RTL file in your SoC design.
« create a top-level RTL file (<proj_name>_Top.v) to match the SoC design, if the SoC design is created from

an Empty Project template and there is no top-level RTL file in your SoC design.

d. (Optional) Modify LPF constraint file (<proj_name>.Ipf) to match the SoC design, if you have modified the SoC
design. This step is a must to the SoC design that is created from Empty Project template.

e. Switch to Process view of the Diamond project (Figure 2.60). Make sure at least one programming file (IBIS
Model, Verilog Simulation File, VHDL Simulation File, Bitstream File, or JEDEC file) is selected in the Export
Files section. Available programming files can be different upon specific device included.
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< >
Filelist  Process Hierarchy—Post Map Resources
TdCons.. & X Output a8 x
- source c:|Initialized UFM Pages: 0 Page.
> pri_run Ex
. Jedec File [0]: Sentry impll.fea
Jedec File [1]: Sentry impll_a.jed
Total CPU Time: 2 secs
Total REAL Time: 2 secs
Peak Memory Usage: 211 MB
Done: completed successfully
v
< > | Output Error Warning* Info*
Ready Mem Usage: 194,752 K

Figure 2.60. Generate Programming Files

f.  Right-click Export Files, and choose Run
used in the Diamond Programmer.

. The programming file is generated. The programming file can be

Note: Refer to the Diamond online help for more details of the Diamond project. Re-launch the Diamond project,

if the project settings are modified in Propel 2.1 Builder.

e To launch Radiant software:

a. Click the Radiant icon

from the Propel Builder toolbar.

b. Lattice Radiant is launched with a Radiant project generated for SoC at background (Figure 2.61).
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Figure 2.61. Radiant Project

c. (Optional) From the File List view of Radiant:

« modify the top-level RTL file (<proj_name>_Top.v) to match the SoC design, presupposition of which is

that there is a top-level RTL file in your SoC design; or

+ create a top-level RTL file (<proj_name>_Top.v) to match the SoC design, if the SoC design is created from
an Empty Project template and there is no top-level RTL file in your SoC design.

d. (Optional) Modify pdc constraint file (<proj_name>.pdc) to match the SoC design, if you have modified the
SoC design. This step is a must to the SoC design that is created from Empty Project template.

e. Click

2.2.15. Launching SDK

Run all. The Programming file is generated. It can be used in the Radiant Programmer.
Note: Refer to the Radiant online help for more details of the Radiant project.

After an SoC design is completed, Propel SDK can be launched in Propel Builder for software development. For
template SoC project, you can launch SDK directly by clicking Run Propel icon from Propel Builder toolbar after

template SoC project created.

1. Click the Run Propel icon

“~~" from the Propel Builder GUI Toolbar. Lattice Propel Launcher (Figure 2.62) opens.
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S Lattice Propel Launcher

Select a directory as workspace

Lattice Propel uses the workspace directory to store its preferences and development artifacts.

~ Browse...

Workspace: Q|

[] Use this as the default and do not ask again
» Recent Workspaces

Figure 2.62. Lattice Propel Launcher Wizard

2. Click Launch. Propel SDK GUI opens and the C Project wizard (Figure 2.63) pops up for loading the system and the
board support package (BSP) to create a C/C++ project.

Q C/C++ Project

Load System and BSP

Correct system environment file and get toolchain parameter

Select system environment file and B5SP package
Browse...

Systemn env:

Select processor core to create C/C++ Project

Core selected: | cpull_inst
Project typer | C
System information

Device Family CPU Name Instance Name

LFCPMNX riscv_mc cpul_inst

® < Back Finish Cancel

Figure 2.63. Propel SDK GUI and C/C++ Project Wizard

3. Click Next. The C/C++ project dialog (Figure 2.64) opens.
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£t C/C++ Project

C/C++ Project
Create C/C++ project of selected type

Project name: | HelloWorld_C

Use default location
Location: | Chlscc\propeh2. hworkspace\HelloWorld__C

Choose file systern: defaul

Project type: Toeolchains:

Browse...

» = GNU Autotools RISC-V Cross GCC
w = Executable
& Empty Project
@ Lattice C/C++ Project
@& Hello World RISC-V C Project
@& Hello World ANSI C Project
» [= Shared Library
» = Static Library
» [= Makefile project

Show project types and toolchains only if they are supported on the platform

® o

Cancel

Figure 2.64. Create C/C++ Project

4, Enter a project name in the Project Name field, such as HelloWorld_C. Click Next. The Lattice toolchain setting

dialog opens (Figure 2.65).
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3 C/C++ Project O X

Lattice Toolchain Setting

Configuration: | Debug ~

Lib Setting  C/C++ Compiler C/C++ Linker

() Mo default libraries (-nodefaultlibs)
() Mewlib

(O Mewlib-nano (--nano.specs)

(®) Picolibc {--specs=picolibc.specs)

Printf Level
(®) Integer only printf (-DPICOLIBC_INTEGER_PRINTF_SCANF)

) Float printf (-DPICOLIBC_FLOAT_PRINTF_SCANF)
O Full printf (-DPICOLIBC_DOUBLE_PRINTF_SCANF)

@' < Back MNext > Cancel

Figure 2.65. Lattice Toolchain Setting Dialog

5. Click Finish. The C/C++ project is created and is displayed using the C/C++ perspective. A perspective is a collection
of tool views for a particular purpose. The C/C++ perspective is for creating C/C++ programs.

Note: Refer to Lattice Propel 2.1 SDK User Guide (FPGA-UG-02127) for more details on how to create a C/C++ project
and develop the C/C++ project in Propel SDK.

2.3. Verification Project Design Flow
2.3.1. Creating a Verification Project

1. Choose File > New Design from the Lattice Propel Builder Menu Bar. The Create System Design wizard opens
(Figure 2.66).
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., Create System Design ot

Design Information
Enter a name for your design and specdify a directory where the design files wil be stored.

Project:

Type: SolC Verification -

Mame: Verification_Project

Location: | C:flsccfpropel/2. 1fworkspace * | | Browse...

Create Project at C:lsce/propel/2. 1fworkspace Verification_Project

Mext = Cancel

Figure 2.66. Create System Design — Design Information Wizard

2. Choose SoC Verification from the Type field.
3. Enter a project name in the Name field, such as Verification_Project.
4. (Optional) Use the “Browse...” option to change the project location in the Location field, if needed.
5. Click Next. The Propel Project Configure wizard is shown as Figure 2.67.
4. Create System Design *
Configure Propel Project
Specify a device or board for project.
Language: Device Information:
: Part Mumber: LFCPMX-100-SLFG&72C
SystemVerilog A
Logic Cells: 96000
Select SoC Project: LUTs: 79872
- HelloWorld.sbx | | Browse... RITEERE B
EER EBlocks: 208
LRAM: 7
M DSP (18x 18 Multiplier): 156
ADC Blocks: 1
PLLs: 4
-
DLLs: 2
PCSs: 2
S AlLUs: 1
DPHYs: 0
PIO Cells: 299
-
PIO Pins: 359
Template Info:
< Back MNext = Cancel

Figure 2.67. Create System Design — Propel Project Configure Wizard
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6. (Optional) The default Hardware Description Language (HDL) is displayed in the Language area. Use the drop-down
menu to change the default language.
Select an existing SBX design by using Browse... to choose an SBX file, such as HelloWorld.
Click Next. The Project Information wizard opens.
Click Finish. A dut_inst of SoC project can be seen in the Schematic view (Figure 2.68).

. Propel Builder [Ciflscc/propel/2.1/workspace/Verification_Project/Verification_Project.sbx] Device: LFCPNX-100-9LFG672C Board: NA - [m] s
File Edit View Design Tools Window Help
[ ’ T
R - A BmEaE 0B QQQQ@
Design View o Schematic Address Ay, Start Page
1% LFCPNX-100-8LFGB72C o
- ﬂ Verification_Project
- ﬁf Instances
- E dut_inst
v {¥ Instances dut_inst
» 27 Ports S e = .~ -
L I Nets / \
¥ Components I :
=y rstn_i led o |m—
Properties | I
Mame: = dut_inst I I
Type: Instance I |
Path: Verification_Project/dut_inst — er_l th_O P
WLNV:  lattice:systembuilder :dut: 1.0 \ }
A —— "4 I
IP Catalog Design View A v ha
Tel Console m]
Finished: "sbp design close" -
% sbp design new -name Verification Project -path {C:/lscc/propel/2.l/workspace/Verification Project/
Verification Project.sbx} -device {LFCPNX-100-SLFG672C} -speed {5 _High-Performance 1.0V}
% sbp_add sbxcomp -name dut -path {C:/lscc/propel/2.l/workspace/HelloWorld/HelloWorld/HelloWorld.sbx}
%
-

Figure 2.68. Verification Project

Note: The default instance name of an imported Design Under Test (DUT) is dut_inst. By default, its boundary is shown
with dotted line, and the filled-in color is gray. If there is any change in the SOC design, the dut_inst DUT block can be
updated accordingly by double-clicking this dut_inst DUT block, or by right-clicking this dut_inst DUT block and

choosing Reconfig.

rii
I+I‘
10. Click the plus sign L=< of this dut_inst DUT block. You can see the whole SoC Design (Figure 2.69). Click the
r="

negative sign L1 to close the expanded bus.
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Figure 2.69. Whole SoC Design

2.3.2. Switching SoC Project to Verification Project
Propel Builder supports switching SoC project to verification project manually after creating an SoC project

1. Create an SoC Project, such as HelloWorld project. Refer to the Creating Template SoC Project section for more

details.
Note: Corresponding Verification project is created automatically when creating a new empty SOC project. Hello World

Templates can have pre-developed Verification projects.

2. Click Switch Verification and Soc Design icon from Propel Builder GUI Toolbar. Propel Builder dialog box

opens (Figure 2.70), if a project is not saved.

. Propel Builder >

o Save changes made to HelloWorld before opening ancther system design?

Yes Mo Cancel

Figure 2.70. Propel Builder Dialog Box

3. Click Yes in the Propel Builder dialog box. The Propel Builder GUI switches to verify the project (Figure 2.71).
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4. Propel Builder [C:/lscc/propel/2.1/workspace/HelloWorld/verification/HelloWorld_v.sbx] Device: LFCPMNX-100-8LFG672C Board: NA - m} X

File Edit View Design Tools Window Help

R = HEErxEHB QQQQ
Deswniliew = Schematic Address % Start Page

a LFCPMX-100-9LFGE72C a
» 1E HelloWarld v
4 Cumpunents

sysclk_rst_geni_inst uart_model1_inst
. dut_rst_of— uart_rx_data_debugp=
bl dut_rst_i th_clk_of— uart_tx_data_debugp=
dut_clk_i dut_clk_o Ik uart_rx_break_debugi— q
ut_inst
th_rst_o rstn uart_rx_valid_debugf— ﬁ__--_: -------- \
| 1
Properties uart_rxd  uart_ty_busy_debugi— I :
| 1 ted_op——!
Name: [ uart_tx_en_debugf— :rstn_i ]
i H ] lod_ob=
Type: Instance ¥ uart_txd i."xd_l :
Path: HelloWorld_v H Sy — J
VLMY: |attice:systembuilder:HelloWorld_v:1.0
File:  C:flsccfpropelf2. 1jworkspace/HelloWorld/ |
] »
IP Catalog Design View F v ad
Tel Console |

% sbp_design close
INFO - Finished: sbp_design close
Finished: "sbp_design close"

% sbp_design open -name HelloWorld v -path {C:flSCC/pIDpElfz.l/WDIkspaCEf:‘lEllDWDIlEi/VEIifiCEt,iD:lf:‘lEllDWDIld_V.be}
%

Figure 2.71. Switching to Project Verification

Note: If the SoC project needs to be re-configured, click Switch Verification and Soc Design again to switch the

verification project to the SoC project.

2.3.3. Opening a Verification Project

Refer to the Opening an SoC Existing Project section for procedure in detail.

2.3.4. Adding Modules, IPs and VIPs

Refer to the Adding Modules section for procedure in detail.

2.3.5. Working with the Schematic View

Refer to the previous Working with the Schematic View section for procedure in detail.

2.3.6. Connecting Modules

Refer to the previous Connecting Modules section for procedure in detail.

2.3.7. Monitoring DUT

This feature is available to an SOC Verification project only. In Propel Builder, the pin inside DUT can be connected to
the input pin of a VIP. The connected pins can be found at both ends of the orange line, as shown in Figure 2.72. Only
pin, pin bus are supported in the current release of Propel Builder.
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Figure 2.72. Monitoring DUT

The testbench generated for this Verification project is shown in Figure 2.73. This testbench file can be used for
simulation.

:lk_r;t_gEnl_inst_dut_ﬂlk_i_nat;

clk rst genl inst dut clk i net = dut inst.osc0 inst.hf clk out o;

clk _rst genl

clk rst genl inst

k_rst_genl inst dut ¢ ll:_:i._netl) .
1k _rst_genl inst_dut_clk o net),

1 inst tb rst o net)

Figure 2.73. Testbench of the Verification Project

2.3.8. Generating Simulation Environment

1. Click the Generate icon 2 from the Propel Builder Toolbar to generate a testbench file including the scripts for
the chosen simulator, file list for HDLs, and some other files. The testbench file structure is shown in Figure 2.74.
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[sim] -- generated simulation environment
[hdl_header]
soc_regs.v -- register definitions of all the components in DUT/SOC
sys_platform.v  -- base address, user settings of all the components in DUT/SOC
[misc]
* K -- all the mem, hex, txt files will be copied here
flist.f -- file list for HDLs
msim.do -- do script for simulator, it can be gsim for Questasim
wave.do -- do script for adding signals in waveform window
<project_name>.sv -- top testbench, SystemVerilog based

Figure 2.74. Testbench File Structure

Unlike those HDLs generated in the SOC design, the testbench generation in the Verification project is just a start
point for you to work with. Make sure that you generate a new testbench, if there is an existing simulation
environment. A dialog box pops up prompting you to make a choice of Yes or No (Figure 2.75).

% Propel Builder >

Current simulator has been changed. This operation will overwrite the most
recent simulation result. Do you want to continue?

Yeg Mo

Figure 2.75. Propel Builder — A Reminding Dialog Box

2.3.9. Launching Simulation

1. Click Launch Simulation icon from the Propel Builder Toolbar to launch simulation.

2. The default simulation tool, ModelSim, OEM version, opens (Figure 2.76).
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¥|Name [Type (fitered) [state  [order Helloworld_v/dut i...
JHeloWorld _v/dut i
Heloworld_v/dut i...
JHeloWorld _v/dut i
HelloWorld_v/dut_i... 0001
HeloWorld_v/dut_i. SRR 11111111131111311233131131333313
JHeloworld_v/dut i
JHeloWorld _v/dut i
JHeloworld_v/dut i
JHeloWorld _v/dut i
JHeloworld_v/dut i
JHeloWorld _v/dut i
< | | I
Wby B venavise | Gsm | EElE LIl » > [ ]
£ Transcript H ) x]
[+ + Warning: (vsim-3722) HelloWorld_v.sv(l04): [TEMEC] - Missing connection for port 'led o'. =}
¢ ** Warning: (vsim-2685) [TFMPC] - Too few port connections for 'cpul_inst'. Expected 28, found 27.
# Time: 0 £s Iteration: /HelloWorld_v/dut_inst/cpul_inst File: ../../HelloWorld/HelloWorld.v Line: 1261
k ** Warning: (vsim-3722) World/HelloWorld.v(1261): [TFMPC] - Missing connection for port "timer_irg o'.
+ ** Warning: (vsim-3015) [ECDEC] - Port size (<protected>] does mot match conmection size
i Time: 0 £ Iteration: 0 Protected: /HelloWorld w/dut_inst/pll0_inst/lscc_pll_inst/gen_no_refclk mcn/u PLL/PLL_: 1ns:/<prm:er.|:sd> File: /home/rel/ng3_l.153/rtf/cae_library/simulation/verilog/controlpack_cre/lfcpnx
|/PLL_CCRE.v Line: 196
[+ +* Warning: (vsim-2695) [TFMEC] - Too few port connections for 'sysclk_rst_genl_inst'. Expected €, found 4. -
¢+ Time: 0 £s Iteration: 0 Instance: /HelloWorld_v/sysclk_rst_genl_inst File: BelloWorld v.sv Line: 117 =
Now: 1ms Delta: 2 HeloWorld _v/dut_instjrxd i Y

Figure 2.76. Simulation GUI

Note: Before launching simulation, you can change Simulator to Questasim by clicking Design > Options from the
Builder Menu bar. Builder Options Wizard opens (Figure 2.77). Click Directories to set a desired Questasim
Location.
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2. Options

Themes:

General

IP TOOL

IP Install Path:

Color

Radiant Location

Diamond Location

Light

Metwark Settings

Directories

Move IPs to new location

C:/Usersyzhao3 PropellPLocal

Questasim Location

(0].4

Set Default

Cancel Apply

Figure 2.77. Builder Options Wizard
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3. IP Packager

IP Packager is a tool for you to create an IP package easily. You can edit port, file, parameter, and memory in the IP
Packager, and pack a customized IP directly.

IP Package is a collection of all required files related to an IP. All the related files are organized in different directories
(Figure 3.1).

- [IP Package]
- metadata.xml
- [rtl]
- [testbench]
- [1ldc]
- constraint.ldc
- [driver]
- [ip_eval]
- [plugin]
- plugin.py
- [doc]
- introduction.html
- EULA.tXxt

Figure 3.1. Example Directories and Files of an IP Package

¢ metadata.xml [mandatory]: XML metadata file which mainly describes legal usage and interface of an IP.

e rtl [mandatory]: Directory for parameterized HDL source files. HDL source files contain configurable parameters for
you to configure.

e testbench [optional]: Directory for test bench files.
e |dc [optional]: Directory template constraint file. The file name should be “constraint.ldc”.
e driver [optional]: Directory for driver source code files.

e plugin [optional]: Directory for Python script to implement internal logic of the soft IP. The file name of Python
script should be “plugin.py”.

¢ doc[mandatory]: Directory for documentation files. It should contain one mandatory introduction file, one
mandatory license agreement file, and other optional documents.

The custom IP package can be used in Propel Builder for SoC design. IP instance package (Figure 3.2) is generated when
user configures IP in Propel Builder.

- <instance name>

- <instance name>.cfg

- <instance name>.ipx

- component.xml

- design.xml

- [rtl]
- <instance name>.v
- <instance name> bb.v

- [constraints]
- <instance name>.ldc

- [driver]

- [ip_eval]

- [misc]
- <instance name> tmpl.v
- <instance name> tmpl.vhd

Figure 3.2. Example Directories and Files of an IP Instance Package
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3.1. Launching IP Packager

1. Choose Tools > ¢ IP Packager from the Lattice Propel Builder Menu Bar.

Note: You can also launch IP Packager from Radiant 3.1 or later version, if you have installed Radiant. To launch IP

Packager, you can go to the Windows Start menu and choose Programs > Lattice Radiant Software > Accessories >
IP Packager.

2. P Packager is launched (Figure 3.3)

™ 1P Packager — [m] K

File Edit Help

@D

Figure 3.3. IP Packager GUI
3.2. Packing Custom IP Flow
3.2.1. Opening an IP Directory

1. Choose File > Open IP Directory from the Propel Builder Menu, or Click the Open Design icon from
Propel Builder Toolbar. The Select Folder dialog opens (Figure 3.4).
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€« v 4 <« workspace » IPs » gpio » v | D 2 Search gpio
Organize = Mew folder = - o
doc "™ MName Date modified Type
lemb doc 10/13/2021 1:28 PM File folder
& OneDrive driver 10/13/2021 1:28 PM File folder
plugin 10/13/2021 1:28 PM File folder
EH This PC rl 10/13/2021 1:28 PM File folder
) 30 Objects testbench 10/13/2021 1:28 PM File folder
I Desktop
Documents
‘ Downloads
J‘ﬁ Music
[&] Pirtures v £ >
Folder: | gpic
Select Folder Cancel

Figure 3.4. Select Folder Dialog

2. Choose a desired IP directory.

Click Select Folder. The IP Packager GUI shows the IP Package project (Figure 3.5). IP package project includes three
mandatory parts (Meta Data, Design File, and Doc) and two optional parts (Test Bench and Misc) that need to be
edited. Refer to the Editing IP section for more details.
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File Edit

&= [

Project

Meta Data
Dresign Files
Test Bench
Misc

Doc Assistant

*p Packager - C:/lscc/workspace/IPs/gpio

Meta Data
Basic Info
~ Parameters
3
~ Ports
[
v < ouT
v O INOUT
~ Interfaces
APB_SD
INTR.
* Memory Map
b gpic_mem_map

Application Output | &=

set ip directory: C:/lscc/workspace/IPFs/ogpio

Vendor:
Library:
Name:
Display name:
IP version:

Category:

Supported platform:

Minimal Radiant version:

Minimal Propel version:

Supported Device Family

LFCPNX

LFD2MN

LFMXO5

LIFCL

LEMMNE

latticesemi.com
ip

gpio

GPIO

16.0

Processors_Controllers_and_Peripherals
Radiant
30

21

start a new ipk project from C:/lscc/workspace/IP=s/gpio

Output

Propel

Figure 3.5. IP Packager with IP Project Details

Note: If you prepared all directories and files of an IP module in advance, the IP Packager can load the information. If
you do not want to update the IP module information, you can skip the Editing IP section below.
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3.2.2. Editing IP

1. From the IP Packager Project area, click Mata Data. The IP Packager GUI shows Meta Data information in detail
(Figure 3.6).

File Edit

&= [

Project

Design Files
Test Bench
Misc

Doc Assistant

™*1 1P Packager - C:/lscc/workspace/IPs/gpio - O *
Help
+
Meta Data
Basic Info
+ Parameters Vendor: latticesemi.com
= Library: ip
* Ports
b IN Name: gpio
v ouT T P10
isplay name:
v D INOUT ¥
* Interfaces IP version: 1.6.0
APB_S0
INTR. Category: Processors_Controllers_and_Peripherals
v Memory Map Supported platform: Radiant Propel
b gpio_mem_map
Minimal Radiant version: 3.0
Minimal Propel version: 2.1
Supported Device Family -
LFCPMX
LFD2NX
LFMX0O3
LIFCL
LFMMNX -
Application Output | &1 X
set ip directory: C:/lscc/workspace/IPs/gpio 5
start a new ipk project from C:/lscc/workspace/IPs/gpio
-
Output

a. To configure basic information:
Click Basic Info from Meta Data view (Figure 3.7).

Figure 3.6. IP Packager with Meta Data Details
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Meta Data

iBazic Info
* Parameters
3
* Ports
o IN
PO OUT
P INOUT
¥ Interfaces
APB_S0
IMNTR
* Memory Map

b gpio_mem_map

Figure 3.7. Meta Data View

¢« You can see the Basic Info properties in detail as shown in Figure 3.8.

Meta Data
:Basic Info f
+ Parameters Vendor: latticesemi.com
g Library: ip
* Ports
» [N Name: gpio
» Sout Displ GPIO
isplay name:
b © INOUT Py
~ Interfaces IP version: 1.6.0
APB_S0
INTR Categaory: Processors_Controllers_and_Peripherals
v Memo.r_',r Map Supported platform: Radiant Propel
F  gpic_mem_map
Minimal Radiant version: 3.0
Minimal Propel version: 2.1
Supported Device Family -
LFCPMX
LFD2MNX
LFMX05
LIFCL
LFMMX -

Figure 3.8. Configure Basic Info

¢ Configure the basic information by entering desired value for a property or checking the checkbox for the
property in the property field. For example, click the Vendor filed to enter a desired vendor value.

Note: IP Packager supports both Radiant and Propel software. IP Packager is based on Radiant 3.0, but
does not support Radiant version of which is lower than 3.0. “Minimal Radiant version” should be set to
3.0 or 3.0+. For Propel, IP Packager is based on Propel 2.1, not support Propel version of which is lower
than 2.0. “Minimal Propel version” should be set to 2.0 or 2.0+. If the version of Radiant or Propel is
invalid, the warning message is shown (Figure 3.9).
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Meta Data
Basic Info
~* Parameters
» [ Tabi
* Pors
N
O out
< INOUT
Interfaces
Memory Map

Figure 3.9. Warning Message of the Invalid Radiant and Propel Version

Vendor:
Library:
Name:
Display name:
IP version:

Category:

Supported platform:

Minimal Radiant version:

Minimal Propel version:

Supported Device Family

2 LFCPNX
[ LFD2ZNX
[E LFMX05
= LFcL

2 LFMNX

E Machx02
[ Machx03D
[ Machx03L

[ MachX03LF

b. To configure parameters:
+ Right-click Parameters from Meta Data view, and choose Add Parameter Tab (Figure 3.10). Parameters
create Tab1l items.

latticesemi,com
ip

gpio

GPIO

1.6.0

Processors_Controllers_and_Peripherals

Radiant

Propel

2.0

2.0
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Meta Data

Basic Info

Add Parameter Tab

—r NG
Interfaces
Mernory M:

Figure 3.10. Right-click Menu of Parameters in the Meta Data View

Right-click Tabl under Parameters from Meta Data view, and choose Add Parameter Group. Group1 is
newly added under Tab1 (Figure 3.11). Groupl is used to group the settings. Settings of the same
“groupl” are displayed as sub-items under a group item on GUI. The settings with the same “group1”
should be written continuously if you want GUI to group them under one group item, otherwise you can
see multiple groups with the same name in GUI. Tab1 is used to Group the “groupl” groups. “groupl”
groups of the same “Tab1” are displayed in a separate page on GUI. So, two level hierarchy is supported
in GUI display. Unlike ‘groupl’, you need not write setting nodes with the same ‘Tab1’ continuously but
you must follow the rule for ‘groupl’ that all the settings with the same ‘group1’ must be in the same
‘Tabl’.

Basic Info
* Parameters
- Tab1
Group1
* Ports
I
ouT
o INOUT

Interfaces

Mernory Map

Figure 3.11. Groupl Added to Tab1l

Right-click Group1 under Tab1 from the Meta Data view, and choose Add Parameter. NewParam1 is
newly added under Group1 (Figure 3.12).
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Meta Data
Basic Info
Mote:
* Parameters Property Value Click table to change value.
M title
- General
NewParam‘I type param
~ Ports value_type string
r N
default
v O ouT
» @ INOUT value_expr
* Interfaces .
options
APB_SD
INTR output_formatter

> Memaory Ma
.ry P bool_value_mapping
¥ gpio_mem_map

editable
hidden
drc

regex
value_range

config_groups

description

Figure 3.12. NewParam1 Added to Groupl

« Double-click NewParam1 to rename the parameter (Figure 3.13). The parameter name is also used as the
unique ID of the parameter setting.

Baszic Info
* Parameters

- Tab1

A Groupl

* Ports

N

o out

O INOUT
Interfaces
Mernory Map

Figure 3.13. Rename a Parameter

« Double-click the property value field to enter the desired parameter value, or select the desired value
from drop-down menu (Figure 3.14). The properties are thus configured. Property listed in bold must be
configured. The details of each property is shown in Table 3.1
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= Parameters Property Value Python expression to determine whether
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~* Ports
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o INOUT
Interfaces value_expr
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description

Figure 3.14. Configure a Parameter

Table 3.1. Details of Parameter Property

Property Value Mandatory Description
title String No Short title of the setting. If “title” is not specified, value of “setting” is used.
Example:
title="Device Architecture”
type param, Yes A setting can be a Verilog parameter, Verilog macro definition or user input.
input, Param, verilog_macro and input settings can be used to compute values of
command other param and input settings. They only differ in generated files. param is
written out as a Verilog parameter value pf the IP module, verilog_macro is
translated to a Verilog macro definition by the define compiler directives, but
input is not. Command shows as a button.
Example:
type="param”
value_type bool, string, Yes Type of the value. Supported types are bool, int, float, string, and path. The
int, float, int type supports unlimited precision.
path The float type supports the precision of float type of C programming language.
Refer to the Characteristics of Floating Types section of the 1999 ISO/IEC C
Standard for details.
The path type indicates a string which represents a path. “/” is used as
separator.
Example:
value_type="string”
default Python No Default value of the setting. If the setting has no “default” attribute but has
expression "options" attribute, the first option is picked as default value. If the setting has
neither “default” attribute nor “options” attribute, the initial value of setting is
set to O for int, 0.0 for float, “” for string and False for bool. By default, it is not
allowed to reference to other setting values. Use value_expr as reference
values.
Example:
default="LIFCL"
value_expr Python No Python expression to compute the value of the setting. The result is used as the
expression parameter value if the setting is not editable. For example, divider is calculated
by frequencies.
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Property Value Mandatory Description
Example:
value_expr="int(round((sys_clock_freq * 250.0) / i2c_left_desired_frequency))-
1
options Python list No Candidate options for the setting, which is used by GUI to display a dropdown
or list of selector. It can be set to a simple list or a list of tuples. If it is a simple list,
tuples elements are displayed and written. If it is a list of tuples, the first item in tuple
is displayed and the second item in tuple is written.
Example:
options="[0.1, 0.2, 0.5, 1.0]”
output_forma | str No Control how parameter values are written in output RTL files. Following
tter formatters are supported.
str: parameter values are written as strings
nostr: quotation marks of strings are removed
Example:
output_formatter="str”
bool_value_ Python tuple | No The map-to-map bool values to dedicated strings. By default, bool values are
mapping or list with 2 written as 1, 0.
string Example:
elements bool_value_mapping="(‘True’, ‘False’)”
editable Python No Python expression to determine if the setting is editable. When a setting is not
expression editable, it is grayed out in GUI display and its value is computed by value_expr.
Otherwise, user input is used.
Example:
editable="(FEEDBACK_PATH =="'PHASE_AND_DELAY')
(FEEDBACK_PATH is a setting ID in metadata.xml)
hidden True No Python expression to determine whether or not the setting is hidden in GUI. If
hidden is set to True (default is False), the item is hidden in GUIL. The expression
is resolved to boolean value after the user setting is changed.
Example:
hidden="True”
drc Python No Python expression to do DRC on the setting. True means DRC pass.
expression Example:
drc="check_valid_addr_pre(12C_LEFT_ADDRESSING_PRE,i2c_left_addressing_wi
dth)"
(check_valid_addr_pre is defined in plugin.py
setting ID: 12C_LEFT_ADDRESSING_PRE
i2c_left_addressing_width
)
regex Regular No Regular expression to do DRC on the value. For example, the value should be
expression prefixed by “0Ob”.
Example:
regex="0b[01]+”
value_range Python tuple | No Valid range of setting value, which is used to do DRC on the setting. The
or list with 2 maximum value can be infinity “float(‘inf’)”.
comparable Example:
elements value_range="(0, 1023) if(i2c_right_enable) else (-9999, 9999)"
config_groups | Python No A name or names to group settings together. It is copied from IP-XACT
expression configGroups attribute, and only supports “SystemBuilder” value. If it is
defined, related RTL parameter is brought out to IP instance top module, so that
System Builder can re-define its value.
description String No Detailed description of the setting.
macro_name | id, value No Specify how to name the Verilog macro in ‘verilog_macro’ type setting item, the

ID or value of this setting item. The default value is ‘setting’, which means the
setting’s ID will be defined as a Verilog macro. If it is set as ‘value’, the evaluated
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Property Value

Mandatory

Description

setting value is the Verilog macro.
Example:

maro_name= "value"

Result: ‘define <setting value>

Note: This is only be considered in the setting item whose ‘value_type’ attribute

is set to ‘string’.

¢« Repeat steps above to configure all parameters as desired.

c. To configure Ports:

+ Click Ports from the Meta Data Tree, three port types (IN, OUT, INOUT) (Figure 3.15) are listed.

« Right-click IN from the Ports area, and choose Add Port (Figure 3.16).

* Ports

Meta Data

IM
ouT
= INOUT

Figure 3.15. Three Port Types

Basic Info
* Parameters

* Ports

—r NG
Interfaces
Mermnory M: Add Port

Infer Ports from HDL

Figure 3.16. Right-click Menu of the IN Port

Note: You can add all ports by using Infer Ports from HDL, if you prepare valid RTL files and add RTL files in Design
Files section. Click Infer Ports from HDL, the Add inferred ports to meta data wizard pops up (Figure 3.17). If you
have added some ports and then choose Infer Ports from HDL, all the previously-added ports are removed and
only ports from the HDL file can be added.
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Figure 3.17. Add inferred ports to meta data Wizard

« NewPortl is created. Double click NewPort1 to rename the port (Figure 3.18).

* Ports
* [N

gpio_|

O out
T INOUT

Figure 3.18. Rename an IN Port

« Configure all properties of the IN port as desired (Figure 3.19). Property listed in bold must be configured.

The details of each property is shown in Table 3.2.
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Figure 3.19. Configure an IN Port

Table 3.2. Details of Port Property

Property Value Mandatory Description

range Python tuple or list No Range of this port. It should be a Python expression whose
with two-integer evaluation result is a tuple or array with two elements.
elements Example:

range="(A_WDT-1, 0)"
(A_WDT is a setting ID)

conn_port Valid Verilog No Name of port of IP core module to which this port connects.
module name Value of “name” is used if “conn_port” is not specified.
Example:
conn_port="CIk"
conn_range Python tuple or list No Range of conn_port. It should be a Python expression whose
with two-integer evaluation result is a tuple or array with two elements.
elements Example:

conn_range="(A_WDT-1, 0)"
(A_WDT is a setting ID)

stick_high Python expression No Python script. True: tie this port to 1.
Example:
stick_high="True”

stick_low Python expression No Python script. True: tie this port to 0.
Example:

stick_low="no_seq_pins()"
(no_seq_pins is defined in plugin.py)

stick_value Python expression No Python script. Tie port to the evaluation result of this attribute.
dangling Python expression No Python script. True: keep this port unconnected.
Example:

dangling="not USE_COUT"

(USE_COUT is a setting ID)

attribute Python expression No Python script. The value can be written to the .v file as the
attribute of the port.

Example:
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Property Value Mandatory Description
attribute=""(* AAA, BBB=1 *)"”
=>(* AAA, BBB=1*) input PORT;
port_type String No ‘data’, ‘reset’ and ‘clock’ are valid values. The default value is

‘data’.

port_type can be passed to the IPXact component.xml as a
Isccip:isClk or Issccip:isRst node in venderExtensions in
component/model/ports/port.

« Repeat steps above to configure all ports as desired.

d. To configure Interfaces:

+ Right-click Interfaces from the Meta Data view, and choose Add Interface (Figure 3.20). A new interface
Newlnterfacel is created.

Add Interface

Figure 3.20. Right-click Menu of an Interface

+« Double click NewlInterfacel to rename interface (Figure 3.21).

-

Interfaces

49 50

Figure 3.21. Rename Interface

« Configure the interface as desired (Figure 3.22).
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File Edit

& [

Project

Meta Data
Design Files
Test Bench
Misc

Doc Assistant

1 IP Packager - Ci/lsccfworkspace/IPs/gpio - [m] x
Help
+
Meta Data
Basic Infe
~ Parameters Display Mame: APE_S0
=] Description: APB slave port
~ Ports
oM Interface Type: amba.com: AMBA3:APE:r 1p0 <
v O ouT - =
ole: ave ~
b O INOUT
~ Interfaces Mem Map Reference: | gpio_mem_map M
INTR Port Map:
v Memory Map Logical Port Physical Port
b gpioc_mem_map
PADDR apb_paddr_i
PCLK
PCLKEN
PEMABLE apb_penable_i
PRDATA apb_prdata_o
PREADY apb_pready_o
PRESETn
PSELx apb_psel_i
PSLVERR apb_pslverr_o
PWDATA apb_pwdata_i
PWRITE apb_pwrite_i
Application Output | &1 ”
set ip directory: C:/lscc/workspace/IPs/gpio g
load existing ipk project from C:/lscc/workspace/IPs/gpio
-
Quitput

Figure 3.22. Configure an Interface

Repeat steps above to configure all interfaces as desired.
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e. To configure Memory Map:
¢ Right-click Memory Map from the Meta Data Tree, and choose Import Memory Map from CSV
(Figure 3.23). New memory map is created (Figure 3.24).
Note: Propel 2.1 Builder only supports using Import Memory Map from CSV to create memory map.
There are some issues if you use Add Memory Map.

Add Memory Map
Import Memory Map from C5V

Figure 3.23. Right-click Menu of a Memory Map
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P Packager - Ci/lscc/workspace/IPs/gpio

File Edit

= [

Project

Meta Data
Dresign Files
Test Bench
Misc

Doc Assistant

Help

+

Meta Data
Basic Info
- Parameters
v B9
* Ports
PN
v < out
v <D INOUT
¥ Interfaces
APB_SD
INTR.
- Memory Map

Property

description

GPIO memory map

Value

Application Output

Output

rs
4]

set ip directory: C:/lscc/workspace/IPs/gpio
load existing ipk project from C:/lscc/workspace/IPs/gpio

Figure 3.24. Generate New Memory Map
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2. From the IP Packager Project area, click Design Files. IP Packager GUI shows the Design Files information
(Figure 3.25).
] IP Packager - Ci/lscc/workspace/IPs/gpio - [m| pad
File Edit Help
— +
L4l IEI
Project Design Files
Meta Data
[Design Files i RIL Files: Add Remove
Test Bench i
Misc Mame Lib Encryption
Doc Assistant Ci/flscc/workspace/IPs/gpio/rtl/lscc_apb2lmmi.v
C/lscc/workspace/IPs/gpio/tl/lscc_gpiow
Ci/lscc/workspace/|Ps/gpio/rtl/lscc_gpio_lmmiw
Timing Constraint File:
Synplify Pro Constraint File:
application Output | &9 x
set ip directory: C:/lscc/workspace/IPs/gpio A
load existing ipk project from C:/lscc/workspace/IPs/gpio

Output

Figure 3.25. IP Packager with Design File Details

Add button to select a desired rtl file in the Design Files field. Click the

Remove button

e Click the
to remove an RTL file. Use the “...” option to add a desired timing constraint file and synplify Pro

Constraint file.

Note: Design file configuration is mandatory. Specify at least one RTL file. If the RTL file needs to be

encrypted, check the Encryption option for it.
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3.

From the IP Packager Project area, click Test Bench. The Test Bench information is shown in detail (Figure 3.26).

- O X

*1 IP Packager - C:/lscc/workspace/IPs/gpio

File Edit Help
= = +
L4l
Project Test Bench
Meta Data
; 3 Testbench Files:

MName

Misc
Doc Assistant

Ci/lsce/workspace/IPs/gpio/testbench/lscc_ImmiZapb.y

Ci/flscc/workspace/IPs/gpio/testbench/th_top.w

Appication Output | &1
set ip directory: C:/lscc/workspace/IPs/gpio

Output

load existing ipk project from C:/lscc/workspace/IPs/gpio

Add Remove

Lib Encryption

Follow the steps as those for configuring the Design Files to configure the Test Bench

configuration is not mandatory.

Figure 3.26. IP Packager with Test Bench Details

. The Test Bench files
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4. From the IP Packager Project area, click Misc. The Misc related information is shown in detail (Figure 3.27).
Configure Misc information as desired.

™1 IP Packager - C:/lscc/workspace/IPs/gpio - O X
File Edit Help
=
L4
Project Misc
Meta Data
Design Files Document: Add Remove
Test Bench
HWE C:/lscc/workspace/IPs/gpio/doc/introduction. html
Doc Assistant
Driver Files: Add Remove
Ciflscc/workspace/|Ps/gpio/driver/gpio.c x
Ci/lscc/workspace/|Ps/gpio/driver/gpic.h
IP Evaluation Files: Add Remove
Plugin File: | C:flsccfworkspace/IPs /apio/plugin/plugin.py
EULA File:
Application Output | &1 X
set ip directory: C:/lscc/workspace/IP=s/gpio &
load existing ipk project from C:/lscc/workspace/IPs/gpio
Output

Figure 3.27. IP Packager with Misc Details
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From the IP Packager Project area, click Doc Assistant. The Doc Assistant information is shown in detail

(Figure 3.28).

5.

P Packager - Ci/Iscc/workspace/IPs/gpic

File Edit Help
+
A IP

|

Project Doc Assistant

Met.a DET_:E This helps you quickly create an introduction html page for IP.
Design Files
Test Bench Titie:

Misc

Description:

Device support:

Revision history:

Revision Content

Add Remave Save and Add to IP Package

Application Output }_'I

set ip directory: C:/lscc/workspace/IPs/gpic
load eristing ipk project from C:/lscc/workspace/IPs/gpio

Output

Figure 3.28. IP Packager with Doc Assistant Details

Enter the desired title, description, and device in the Title, Description, and Device support fields

accordingly.
Double-click and enter a revision in Revision field. Double-click and enter revision contents in Content

field. Refer to Figure 3.29 as an example. Click the Add button. A new blank row is added to the

Revision History area. You can add desired revision and contents accordingly. Select the revision you want

to delete, and click the Remove button to remove a Revision.

e Click the Save and Add to IP Package button to create an introduction html page and save this file to the IP

package.
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2 IP Packager - C fworkspace/IPs/gpio — O *
File Edit Help
=" =
4]
Project Doc Assistant
Met.a DEFE This helps you quickly create an introduction himl page for 1P,
Dresign Files
Test Bench Title: GFIO
Misc
Doc Assistant Description: General-Purpose InputfOutput (GPIC) peripheral IP provides dedicated memory-mapped  interface to configure GPIO ports as well as the number of input and outy
Device support: | ALL
Revision history:
Revision Content
1.6.0 Updated to support all devices
1.5.0 Added CertusPro-NX support, and updated G5R instance in testbench
141 Updated to fix combinational loop
1.4.0 Added MachX02, MachX03L, MachXO3LF support
1.3.0 Added option to remove tri-state buffer and Mach-MNX device support
1.2.0 Added MachX03D and Certus-MX device support
1.1.0 Added CrossLink-MNX device support
1.0.0 Initial release
Add Remove Save and Add to IP Package
Application Qutput AJ X
set ip directory: C:/lscc/workspace/IPs/gpio =
load existing ipk project from C:/lscc/workspace/IPs/gpio
-
Output

Figure 3.29. Configure Doc Assistant
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3.2.3. Previewing IP

IF IP
1. Choose Edit > I:I IP Preview from Propel Builder menu. Or, click the IP Preview icon I:I from Propel Builder
Toolbar.

2. IP Preview pops up showing the configuration component for the IP module (Figure 3.30), if the IP project
configuration is correct. Otherwise, the IP Packager pops up an error message (Figure 3.31).

[*2] IP Preview x

Configure Component from Module gpio
Version latticesemi.com

Set the following parameters to configure this component.

Diagram ippackager_preview_inst Configure IP
| Property Value
~ General
MNumber of /0 Lines [1 - 32] 1

Remove Tri-5State Buffer
Initial Qutput Yalue (hex) [0 - FFFFFFFF] O

ippackager_preview_inst 10 Direction (hex] [0 - FFFFFFFF] 1

PB S0 Interface APB

" - INTR4H
CIK_1

~ gpio_io[0:0]
resetn |
gpio
L] 2 i Mo DRC issues are found.

Cancel

Figure 3.30. IP Preview Shows Configuration for IP Module

™) IP Packager X

ERROR: No RTL file found.
Click the Add button te add mandatory IP input files --- meta data, RTL and
Document files.

OK

Figure 3.31. IP Packager Pops up Error Message
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3.2.4. Packaging IP
+ +

1. Choose Edit > Package IP from Propel Builder menu. Or, click the Package IP icon from Propel Builder
Toolbar.

2. IP Packager pops up a message showing the packaging is completed successfully (Figure 3.32).

o Package files to IP(Chlscc\workspaceh|Ps\gpichlatticesemi.com_gpio_1.6.0.ipk)

successfully.

8.4

Figure 3.32. IP Packager Pops up Successful Packaging Message

Note: When the setting value is changed, the packaging operation is disabled. You must perform a preview operation
before packaging. If the preview is successful, the packet operation is enabled. Otherwise, error messages are
displayed in the output widget.

3.3. Editing IP Package Files

3.3.1. Meta Data File

Metadata.xml can be generated after editing IP. You also can manually edit the file. IP Platform uses XML file to
describe metadata of a soft IP. Namespace “Isccip” is used in XML file. The content of the XML file consists of three
mandatory nodes including <general>, <settings> and <ports>, five optional nodes including <businterfaces>,
<addressSpaces>, <memoryMaps>, <componentGenerators> and <estimatedResources>. One optional new child node
<outFileConfigs> is added to support the customized IP generation flow in Propel (Figure 3.33).

<lsccip:ip
xmlns:lsccip="http://www.latticesemi.com/XMLSchema/Radiant/ip"
xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-instance"
version="1.0">

<lsccip:general>

</lsccip:general>

<lsccip:settings>

</lsccip:settings>

<lsccip:ports>

</lsccip:ports>
</lsccip:ip>

Figure 3.33. Example XML of Metadata Layout

1. <general>node: describes general information about a soft IP, for example, name, version, and category. Table 3.3
shows the child nodes of <general> node.
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Child Node

Mandatory

Description

vendor

Yes

Soft IP vendor. Official soft IPs should have vendor name.
Example:
“latticesemi.com”

library

Yes

Library of the soft IP. If “library” is not set, the default value “ip” is used.
Example:

wi o

ip”, “interface”

name

Yes

Name of the soft IP. The name must be unique among soft IPs of the same
vendor and library.

Example:

"adder"

display_name

No

Name to be displayed in the software. If “display_name” is not set,
software displays “name” directly.

Example:

“Adder”

version

Yes

Version of the soft IP.
Example:
1.0.0

category

Yes

Category of the soft IP. Category can be hierarchical. Levels are separated
by “”".
Example:

keywords

No

Memory_Modules,Distributed_RAM

Keywords of the soft IP. Multiple keywords are separated by “,”.
Example:

BusType_AHB,BusType_APB

min_radiant_version

Yes

The minimal Radiant version, which supports the soft IP.
Example:
1.0 (no service pack), 1.0.1 (with service pack)

max_radiant_version

No

The maximal Radiant version, which supports the soft IP.
Example:
2.0.

supported_products

No

FPGA products supported by the soft IP.

type

No

Enhancement for cpu IP.

min_esi_version

No

The minimal ESI version, which supports the soft IP.
Enhancement for esi.

max_esi_version

No

The maximal ESI version, which supports the soft IP.
Enhancement for esi.

supported_platforms

No

Default is Radiant, specific for esi.

www.latticesemi.com/legal


http://www.latticesemi.com/legal

s LATTICE

2. <settings> node: describes parameters information that should contain one or more <setting> nodes. In an IP
instance package, Verilog parameters are used to configure the soft IP. All user configurable parameters should be
added to the <settings> section as <setting> nodes. Beside parameters, you can add <setting> nodes for user-input
only. Table 3.4 shows attributes of <setting> nodes.

Table 3.4. Attributes of Setting Nodes

Attribute Value Mandatory Description
id String Yes The unique ID of the setting, which is also be referred as:
Parameter name in RTL codes
Python variable name
Tcl variable name
To make value of the “id” valid in Verilog HDL, Python and Tcl, it should
consist of only letters, digits, and underscore. The first character should be
letter.
Example:
id="num_outputs”
title String No Short title of the setting. If “title” is not specified, value of “setting” is used.
Example:
title="Number of Output”
type param, input, | Yes A setting can be a Verilog parameter, Verilog macro definition or user input.
command Param, verilog_macro and input settings can be used to compute values of
other param and input settings. They only differ in generated files. param is
written out as a Verilog parameter value pf the IP module, verilog_macro is
translated to a Verilog macro definition by the define compiler directives,
but input is not. Command shows as a button.
Example:
type="param”
value_type bool, string, Yes Type of the value. Supported types are bool, int, float, string, and path.
int, float, The int type supports unlimited precision.
path The float type supports the precision of float type of C programming
language.
Refer to the Characteristics of Floating Types section of the 1999 ISO/IEC C
Standard for details.
The path type indicates a string which represents a path. “/” is used as
separator.
Example:
value_type="int"
default Python No Default value of the setting. If the setting has no “default” attribute but has
expression "options" attribute, the first option is picked as default value. If the setting
has neither “default” attribute nor “options” attribute, the initial value of
setting is set to O for int, 0.0 for float, “” for string and False for bool.
Example:
default="1.0"
value_expr Python No Python expression to compute the value of the setting. The result is used as
expression parameter value if the setting is not editable. For example, divider is
calculated by frequencies.
Example:
value_expr="int(round((sys_clock_freq * 250.0) /
i2c_left_desired_frequency))-1"
options Python listor | No Candidate options for the setting, which is used by GUI to display a
list of tuples dropdown selector. It can be set to a simple list or a list of tuples. Ifitisa
simple list, elements are displayed and written. If it is a list of tuples, the
first item in tuple is displayed and the second item in tuple is written.
Example:
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Attribute Value Mandatory Description
options="[0.1, 0.2, 0.5, 1.0]”
output_formatt | str No Control how parameter values are written in output RTL files. Following
er formatters are supported.
str: parameter values are written as strings
nostr: quotation marks of strings are removed
Example:
output_formatter="str”
bool_value_ma Python tuple No The map-to-map bool values to dedicated strings. By default, bool values
pping or list with 2 are written as 1, 0.
string Example:
elements bool_value_mapping="(‘True’, ‘False’)”
editable Python No Python expression to determine if the setting is editable. When a setting is
expression not editable, it is grayed out in GUI display and its value is computed by
value_expr. Otherwise, user input is used.
Example:
editable="(FEEDBACK_PATH == 'PHASE_AND_DELAY')
(FEEDBACK_PATH is a setting ID in metadata.xml)
hidden True No Python expression to determine whether the setting is hidden in GUI. If
hidden is set to True (default is False), the item is hidden in GUI. The
expression is resolved to boolean value after the user setting is changed.
Example:
hidden="True”
drc Python No Python expression to do DRC on the setting. True means DRC pass.
expression Example:
drc="check_valid_addr_pre(12C_LEFT_ADDRESSING_PRE,i2c_left_addressing
_width)"
(check_valid_addr_pre is defined in plugin.py
setting ID: 1I2C_LEFT_ADDRESSING_PRE
i2c_left_addressing_width
)
regex Regular No Regular expression to do DRC on the value. For example, the value should
expression be prefixed by “Ob”.
Example:
regex="0b[01]+”
value_range Python tuple No Valid range of setting value, which is used to do DRC on the setting. The
or list with 2 maximum value can be infinity “float(‘inf’)”.
comparable Example:
elements value_range="(0, 1023) if(i2c_right_enable) else (-9999, 9999)"
config_groups Python No A name or names to group settings together. It is copied from IP-XACT
expression configGroups attribute, and only supports “SystemBuilder” value. If it is
defined, related RTL parameter is brought out to IP instance top module, so
that System Builder can re-define its value.
description String No Detailed description of the setting.
groupl String No Group the settings. Settings of the same “groupl” is displayed as sub-items
under a group item on GUL. The settings with the same “groupl” should be
written continuously if you want GUI to group them under one group item.
Otherwise, you can see multiple groups with the same name in GUI.
Example:
groupl="Output Setting"
group2 String No Group the “groupl” groups. “groupl” groups of the same “group2” is

displayed in a separate page on GUI. So, two-level hierarchy is supported in
GUI display.

Unlike ‘groupl’, you need not write setting nodes with the same ‘group2’
continuously. You must follow the rule for ‘groupl’ that all the settings with
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the same ‘groupl’ must be in the same ‘group2’.
macro_name id, value No Specify how to name the Verilog macro in ‘verilog_macro’ type setting item,

the ID or value of this setting item. The default value is ‘setting’, which
means the setting ID is defined as a Verilog macro. If it is set as ‘value’, the
evaluated setting value is the Verilog macro.

Example:

maro_name= "value"

Result: “define <setting value>

Note: This is only be considered in the setting item whose ‘value_type’
attribute is set to ‘string’.

3. <ports>node: IP module package has some ports in its implementation. These ports should be described in
<ports> section as <port> child nodes. If an input port is stuck to fixed value, or an output port is dangling, the port
is not used and is invisible after generation. Table 3.5 shows the attributes of <port> nodes.

Table 3.5. Attributes of Port Nodes

Attribute Value Mandatory Description
name Valid Verilog port Yes Name of a port.
name Example:
name="Clk”
dir in, out, inout Yes Direction of a port.
Example:
dir="in"
range Python tuple or list No Range of this port. It should be a Python expression whose
with 2 int elements evaluation result is a tuple or array with 2 elements.
Example:
range="(A_WDT-1, 0)"
(A_WDT is a setting ID)
conn_mod Valid Verilog Yes Name of an IP core module to which this port connects.
module name Example:
conn_mod="counter”
conn_port Valid Verilog No Name of port of an IP core module to which this port connects.
module name Value of “name” is used, if “conn_port” is not specified.
Example:
conn_port="CIk"
conn_range Python tuple or list No Range of conn_port. It should be a Python expression whose
with 2 int elements evaluation result is a tuple or array with 2 elements.
Example:
conn_range="(A_WDT-1, 0)"
(A_WDT is a setting ID)
stick_high Python expression No Python script. True: tie this port to 1.
Example:
stick_high="True”
stick_low Python expression No Python script. True: tie this port to 0.
Example:
stick_low="no_seq_pins()"
(no_seq_pins is defined in plugin.py)
stick_value Python expression No Python script. Tie port to the evaluation result of this attribute.
dangling Python expression No Python script. True: keep this port unconnected.
Example:
dangling="not USE_COUT"
(USE_COUT is a setting ID)
bus_interface Valid bus interface No Bus interface name defined in <businterfaces> node.
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Attribute Value Mandatory Description
name Example:

bus_interface=" ahb_slave_0"

attribute Python expression No Python script. The value is written to the .v file as the attribute of
the port.
Example:
attribute=""(* AAA, BBB=1 *)"”
=>(* AAA, BBB=1*) input PORT;

port_type String No ‘data’, ‘reset’ and ‘clock’ are valid values. The default value is

‘data’

port_type will be passed to the IPXact component.xml as a
Isccip:isClk or Issccip:isRst node in venderExtensions in
component/model/ports/port

<buslInterfaces> node: contains a list of all interface ports of the soft IP (Figure 3.34). The description follows
IP-XACT format. Refer to IEEE 1685-2014: |IEEE Standard for IP-XACT, Standard Structure for Packaging, Integrating,
and Reusing IP within Tool Flows for more details. The businterface has a list of portMap, which defines logicalPort
name and physicalPort name. In <ports> nodes, one port can have optional “bus_interface” attribute, which binds
the port with a businterface. If one port is bound to the businterface, its name should match physicalPort name of
one portMap of the businterface, so that port and busInterface/portMap is bound together. Whether or not a port
can be used is based on user configuration. If the port is used, the corresponding portMap in businterface is
written to the output IP-XACT file. Otherwise, the corresponding portMap in businterface is not written to the
output IP-XACT file.
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<lsccip:busInterfaces>
<lsccip:busInterface>
<lsccip:name>AHBL S00</lsccip:name>
<lsccip:displayName>AHBL S00</lsccip:displayName>
<lsccip:description>AHB-Lite slave
port</lsccip:description>
<lsccip:busType library="interface" name="ahblite"
vendor="1lattice" version="1.0"/>
<lsccip:abstractionTypes>
<lsccip:abstractionType>
<lsccip:abstractionRef library="interface"
name="ahblite rtl" vendor="lattice" version="1.0"/>
<lsccip:portMaps>
<lsccip:portMap>
<lsccip:logicalPort>
<lsccip:name>HSEL</lsccip:name>
</lsccip:logicalPort>
<lsccip:physicalPort>

<lsccip:name>ahbl s00 hsel slv i</lsccip:name>
</lsccip:physicalPort>
</lsccip:portMap>
<lsccip:portMap>
<lsccip:logicalPort>
<lsccip:name>HADDR</lsccip:name>
</lsccip:logicalPort>
<lsccip:physicalPort>

<lsccip:name>ahbl s00 haddr slv i</lsccip:name>
</lsccip:physicalPort>
</lsccip:portMap>
</lsccip:portMaps>
</lsccip:abstractionType>
</lsccip:abstractionTypes>
<lsccip:slave>
<lsccip:memoryMapRef memoryMapRef="ahbs mem map"/>
</lsccip:slave>
</lsccip:busInterface>
</lsccip:busInterfaces>

Figure 3.34. Example of businterface Node
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5. <addressSpaces> node: specifies the addressable area seen by bus interfaces of type master (Figure 3.35). The
description follows IP-XACT format. Refer to IEEE 1685-2014: IEEE Standard for IP-XACT, Standard Structure for
Packaging, Integrating, and Reusing IP within Tool Flows for more details.

<lsccip:addressSpaces>
<lsccip:addressSpace>
<lsccip:name>ahbm addr space</spirit:name>
<lsccip:range>4k</lsccip:range>
<lsccip:width>32</lsccip:width>
</lsccip:addressSpace>
</lsccip:addressSpaces>

Figure 3.35. Example of addressSpace Node

6. <memoryMaps> node: specifies the information about the range of registers, memory, or other address blocks
accessible through slave interface (Figure 3.36). The description follows IP-XACT format. Refer to IEEE 1685-2014:
IEEE Standard for IP-XACT, Standard Structure for Packaging, Integrating, and Reusing IP within Tool Flows for more
details and examples.

To represent dynamic availability of some elements, <register> and <field> node are extended with an optional
isPresent element (introduced in IEEE Std 1685-2014), which defines whether the enclosing element is present or
not. The value of isPresent element is a Python expression. Parameters defined in <settings> node can be used in
the expression.

If a register is used based on user configuration, the register is written to output IP-XACT file. Otherwise, the
register is not written to output IP-XACT file.
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<lsccip:memoryMaps>
<lsccip:memoryMap>
<lsccip:name>ahbs mem map</lsccip:name>
<lsccip:description>AHB-Lite Slave 0 memory
map</lsccip:description>
<lsccip:addressBlock>
<lsccip:name>registers</lsccip:name>
<lsccip:displayName>registers</lsccip:displayName>
<lsccip:description>Register Block</lsccip:description>
<lsccip:baseAddress>0</lsccip:baseAddress>
<lsccip:range>4096</lsccip:range>
<lsccip:width>32</lsccip:width>
<lsccip:usage>register</lsccip:usage>
<lsccip:access>read-write</lsccip:access>
<lsccip:register>
<lsccip:name>Status</lsccip:name>
<lsccip:displayName>Status Register</lsccip:displayName>
<lsccip:description>Status Register</lsccip:description>
<lsccip:addressOffset>0x10</lsccip:addressOffset>
<lsccip:size>4</lsccip:size>
<lsccip:volatile>true</lsccip:volatile>
<lsccip:access>read-only</lsccip:access>
<lsccip:field>
<lsccip:name>FIFO Empty</lsccip:name>
<lsccip:displayName>FIFO Empty</lsccip:displayName>
<lsccip:description>Indicates current status of the

interface in the receive direction: 0 - There is data available. 1 - The
FIFO is empty.</lsccip:description>
<lsccip:isPresent> 1 != int setting

</lsccip:isPresent>
<lsccip:bitOffset>0</1lsccip:bitOffset>
<lsccip:bitWidth>1</lsccip:bitWidth>
<lsccip:volatile>true</lsccip:volatile>
<lsccip:access>read-only</lsccip:access>
<lsccip:writeValueConstraint>
<lsccip:minimum>0</lsccip:minimum>
<lsccip:maximum>0</lsccip:maximum>
</lsccip:writeValueConstraint>
<lsccip:testable
testConstraint="unConstrained">false</lsccip:testable>
</lsccip:field>
</lsccip:register>
</lsccip:addressBlock>
</lsccip:memoryMap>
</lsccip:memoryMaps>

Figure 3.36. Example of memoryMaps Node
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7. <componentGenerators> node: contains a list of componentGenerator elements. Each componentGenerator
element defines a generator that is run on generated IP instance package. Each generator is called after other IP
instance package files are generated. For example, a component generator can generate memory initialization file
for a memory IP (Figure 3.37).

<lsccip:componentGenerators>
<lsccip:componentGenerator>
<lsccip:name>memGenerator</lsccip:name>
<lsccip:generatorExe>script/mem gen.py</lsccip:generatorExe>
</lsccip:Generator>
</lsccip:Generators>
Figure 3.37. Example of componentGenerator Node
8.

<estimatedResources> node: contains a list of estimatedResource element. Each estimatedResource element

defines the formula to calculate one type of resource used in the IP instance package. Table 3.6 shows the element
in < estimatedResource> node.

Table 3.6. Elements in estimatedResource Node

Element Value Mandatory Description

name String Yes Name of the resource.

number Python expression Yes Python script to calculate the number of the resource.
9.

<outFileConfigs> node: specifies all customized output file configuration nodes < fileConfig > for whole customized
flow. fileConfig node contains a group of attributes to specify a specific file or directory generation.
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A full description of a soft IP might be large. Metadata.xml supports to build a large XML file from small manageable
chunks. The approach is implemented by Xinclude (Figure 3.38).

metadata.xml
<lsccip:ip version="1.0"
xmlns:lsccip="http://www.latticesemi.com/XMLSchema/Radiant/ip"
xmlns:xi="http://www.w3.0rg/2001/XInclude">
<lsccip:general> .. </lsccip:general>
<xi:include href="setting.xml" parse="xml" />
<xi:include href="memory map.xml" parse="xml" />
<xi:include href="address space.xml" parse="xml" />
<xi:include href="bus interface.xml" parse="xml" />
<lsccip:ports> .. </lsccip:ports>
</lsccip:ip>

setting.xml
<lsccip:settings
xmlns:lsccip="http://www.latticesemi.com/XMLSchema/Radiant/ip">
<lsccip:setting id="int setting" type="input" value type="int"
conn _mod="example" default="1" title="Integer Setting" />
<lsccip:setting id="bool with value mapping" type="param"
value type="bool" conn mod="example"

default="False" bool value mapping="('Enabled',
'Disabled')" /> B -
</lsccip:settinas>

Figure 3.38. Example of Xinclude Usage

You can use metadata.xsd in Appendix A to check the metadata file. For those elements borrowed from IPXact, refer to
the related xsd files of IPXact.

3.3.2. Implementation RTL Files

You should put all IP implementation RTL files in ‘rtlI’ sub directory of whole IP package. Lattice Builder platform does
not support hierarchical rtl directories. All RTL sources can be put in one directory level. Three file suffix names (‘.v/,
‘.sv’ and ‘.vhd’) are supported for RTL files to represent ‘Verilog’, ‘System Verilog’ and ‘Vhdl’ language types
accordingly.

IP Platform always generates a wrapper module by default for the whole IP generation. This wrapper is in Verilog HDL
no matter what the language type of the IP implementation RTLs is. Providing a Verilog-HDL top to handle the interface
translation among different language types is strongly recommended.

If the IP is implemented in Verilog HDL (including System Verilog) only, all the contents are copied in one .v/.sv RTL file
and modules are defined in the wrapper top module. All module names have unified naming rule to avoid name
collision such as Top module name, PMI module name, Primitive module name, Blackbox module name.

If some portions of an IP module in the RTL file are encrypted, the corresponding portions generated in Verilog file are
also encrypted.
All the RTLs are kept and copied to an IP instance directory, if there is VHDL in IP implementation RTLs. Therefore, the

module-naming rule does not need to be unified. You can specify different lib (default is work) for VHDL source that is
specified in “wrapper” file generator (Figure 3.39).

<lsccip:outFileConfigs>
<lsccip:fileConfig name="wrapper" lib='test2.vhd=1ibA;test3.vhd=1ibB' />
</lsccip:outFileConfigs>

Figure 3.39. Example of Specifying Lib for VHDL
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3.3.3. Python Script Plugin File

Python expressions can be used in metadata file to implement complex logic. To support complex logic, you can add
any python functions in plugin.py file (Figure 3.40) of an IP package, and then call the functions in Python expressions in
metadata file.

Each setting item value can be referred to in a Python expression in metadata.xml by its ID as a Python variable. An
expression is evaluated by demand. The plugin has its individual namespace and all the setting items values are
exported to plugin as a global map variable IP_SETTINGS. You can use IP_SETTINGS [item ID] to refer to an item or set
its value in plugin code.

A global variable *__PLUGIN_VER’ is defined with value ‘2.0’. You can check this variable if you want to provide a plugin
that can work on both current and legacy IP platforms.

def cntr_opt():

$return {"Down" :0,

# " 'J'p L 1,
¥ "UpDown™: 2}
return [ ("Down" . Oy,

("up" 1),

("UpDown™, 2}1]

def cntr ldir(}:
return ((CNTR DIR = 0) | (CHTR DIR = 1})

def cntr_wdt():
if (CHNTR _WIDTIH < 2):
return 2
else:

return CHNTE_WIDTH

def cntr hv

if (CHNTE_HVALUE <= CNTR_LVALUE):
ret = 0

PluginUtil.post_error("Higher count wvalus should be greater than the Lower count value.™)
else:

ret = 1
return ret

¥ = runtime info.device info.architecture (values)

Tdef get_device name (value):
retorn =

Figure 3.40. Template of Plugin File
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3.3.4. Memory Map CSV File

Propel 2.1 Builder supports importing memory map from a CSV file to create memory map. You can edit a CSV file.

Figure 3.41 shows the CSV file template. Each row to be imported is with one of the keywords among MEMORYMAP,

REGISTER, and FIELD. Row with no keyword is ignored, such as the header row (orange squared part in Figure 3.41).
The header row is to help identify the column.

A B T D E F G H | ]
I 0 1 2 4 5 7 3 E)

2 | name description baseAddress range width

3 |MEMORYMAFP ABC descl 0x0 32 64

4 | name displayMame  description addressOffset size volatile access

3 |REGISTER QSPI_CTRL QSPI_CTRL Q5PI Control Register 0x00 32 TRUE read-write

6 | field displayMame  description bitOffset bitWidth volatile access default testable

DEFAULT_S
7 |FIELD spi_mode spi_mode Sets the SPI mode 0 2 TRUE read-write PI_MODE TRUE
DEFAULT_S

& |FIELD sck_div sck_div Sets the SPI clock divider 3 TRUE read-write CK_DIV TRUE

9 |FIELD reserved reserved Reserved bits 5 26 TRUE read-write 0 TRUE

10 |FIELD soft_reset soft_reset Resets internal soft logic 31 1 TRUE read-write 0 TRUE

11 | name displayMame  description addressOffset size volatile access

12 |REGISTER CMD_DATA CMD_DATA Command Data Register 0x04 32 TRUE read-write

13 | field displayMame  description bitOffset bitwidth volatile access default testable
Command data to transmit
in transaction phase 1

14 |FIELD cmd_data cmd_data (always big endian) 0 32 TRUE read-write 0 TRUE

15 | name displayMame  description addressOffset size volatile access

16 |REGISTER TX_FIFO_DATA TX_FIFO_DATA Tx FIFO Data Register 0x08 32 TRUE write-only

17 name displayMame  description bitOffset bitWidth volatile access default testable
Data to transmit in

18 |FIELD tx_fifo_data  tx_fifo_data  transaction phase 2. 0 32 TRUE write-only MNA FALSE

Figure 3.41. Example of Memory Map CSV File
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4. TCL Commands

Propel Builder provides TCL commands to execute actions. You can manually enter TCL commands in Tcl Console
(Figure 4.1), if you prefer using command lines rather than using the GUI.

Tdl Console

% sbp design close
INFO - Finished: sbp design close
Finished: "sbp_design close™

% sbp design open -name hellc v -path {G:/Lattice/project/Raptor/tool/hw/hello_v/hello_v/hello_v.sbx}
% sbp design close

INFO - Finished: sbp design close
Finished: "sbp design close™

Figure 4.1. Tcl Console

4.1. sbp_design

The sbp_design command is used as one of the high-level management commands such as opening, closing, of the
design files created by the Propel Builder.

4.1.1. Open

Opens an existing Propel Builder design for modification.
Usage sbp_design open -name <design name> -path <design path> [-device <device name>]

Example sbp_design open -name projectl -path projectl.sbx

4.1.2. Close

Closes a Propel Builder design currently opened.

‘Usage |sbp_design close

4.1.3. New

Creates a new Propel Builder design.

Usage sbp_design new -name <new design name> -path <new design path> -device <device name> -

language <language type > —board <board name>

4.1.4. Save

Saves the current Propel Builder design to file on disk, or save it as a new file. You can choose to save the design to the
project location (Example 1) or to a specific path (Example 2).

Usage sbp_design save [-path <new design path>]
Example 1 sbp_design save
Example 2 sbp_design save -path new_design.sbx
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4.1.5. Drc

Runs the design rule check for the Propel Builder design file.

Usage

sbp_design drc

4.1.6. Generate

Generates RTL code to instantiate and connect the IP cores specified in the Propel Builder design file.

Usage

‘sbp_design generate

4.1.7. auto_assign_addresses

Automatically assigns memory mapped addresses to all the slaves in the system. These addresses should be chosen to
avoid slaves with multiple non-contiguous address ranges.

Usage

sbp_design auto_assign_addresses

4.1.8. Launch SoC Verification Engine

Launches the verification engine to verify design.

Usage

sbp_design verify [-h] [--workfolder <workfolder_path>] [--sbx_file <sbx_file_path>]
{sim_gen,pfr_pack,regmap_gen,auto_run}

positional arguments: {sim_gen,pfr_pack,regmap_gen,auto_run} specify the application
sim_gen Simulation Generation Flow
pfr_pack PFR Security Engine Packager Flow
regmap_gen Memory Map Generation Flow
auto_run Automation Flow

optional arguments:
-h, --help show this help message and exit
--workfolder WORKFOLDER, -wf WORKFOLDER
assign the working folder. Otherwise, the default one (current working folder) will be
used
--sbx_file SBX_FILE, -sf SBX_FILE
specify the sbx file

Example

sbp_design verify --workfolder ./mem_map --sbx_file D:/ /XO3D_lInitial/XO3D_Initial.sbx
regmap_gen

4.1.9. Execute PGE Engine

Runs command with different parameters to call SGE function, DGE function, and Signature.

e  Runs command to call SGE to generate files for SDK.

Usage

sbp_design pge sge —i <input path> [-o <output path>]

-i [Required] the top-level SoC project sbx file full path.

-0 [Optional] output full path, if the parameter is not specified, output path is the same as SoC
project path. sge folder is generated at output path, at present sge folder under the SoC project root
directory.
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e  Runs command to call DGE to generate TCL script that can be used to generate a Diamond or Radiant project.
Usage sbp_design pge dge —i <input path> [-o <output path>] [-diamond [-radiant]

-i [Required] the top level SoC project sbx file full path.

-0 [Optional] output full path, if the parameter is not specified, output path is the same as SoC
project path. For DGE, tcl script and related files are generated at output path. At present, Diamond
or Radiant project share the same workspace with SoC project.

-diamond [Optional] flag to execute DGE for diamond project.

-radiant [Optional] flag to execute DGE for Radiant project.

e  Run command to generate signature.

PGE gets partial UFM3 contents including version packet (C), Sentry PFR configure data (D), and call Flash Address
Tool to sign with private key from Factory HSM.

Usage ‘sbp_design pge gen_signature -cfile <c binary file> -dfile <d binary file> -output <output binary file>
4.1.10.Undo

Undo operation. Currently, software only supports single undo.

Usage Iundo

4.1.11.Redo

Redo operation. Currently, software only supports single redo.

Usage redo

4.1.12.Set Device

Modify the device information including device, package, speed, operating condition.
Usage sbp_design set_device -device <device name> -speed <speed value> -package <package value> -
operating <operating condition>

4.2. Other TCL Commands

The following commands are used for specifying connectivity and IP instantiation to the Propel Builder backend.

4.2.1. sbhp_add_component

Instantiates an IP component into the system. Must specify the component VLNV identifier. This corresponds to a
component instance in the IP-XACT design. For example, the command below can instantiate an AHB-Lite interconnect
component.

Usage sbp_add_component -vinv <VLNV> -name <instance_name>

Example sbp_add_component -vinv lattice:ip:ahbl_interconnect:1.0 -name ahblite_interconnect

www.latticesemi.com/legal


http://www.latticesemi.com/legal

s LATTICE

4.2.2. sbp_add_sbxcomp

Instantiates a hierarchical component from sbx file into the system.

Usage sbp_add_sbxcomp -name <hname> -path <sbx_file_absolute_path_name>

Example sbp_add_sbxcomp -name sim_comp -path “C:/test/test.sbx”

4.2.3. shp_add_gluelogic

Instantiates a gluelogic component into the system.

Usage sbp_add_gluelogic —-name <instance_name> -logicinfo <logic json info from sbp_create_glue_logic>

Example sbp_add_gluelogic -name equation_module_inst -logicinfo [sbp_create_glue_logic equation

equation_module {} { {"expr":"!A & IB","module_name":"equation_module"}}]

Note: This is an internal command. Modify existing usage is not recommended.

4.2.4. sbhp_create_glue_logic

Create gluelogic information when adding gluelogic component. rtl_path must be a file path if gluelogic comes from a
file. Else be empty.

Usage sbp_create_glue_logic <type> <module_name> <rtl_path> <json cfg data>

Example sbp_add_gluelogic -name equation_module_inst -logicinfo [sbp_create_glue_logic equation
equation_module {} { {"expr":"!A & IB","module_name":"equation_module"}}]

Note: This is an internal command. Modify existing usage is not recommended.

4.2.5. shp_add_port
Creates a top-level I/0 port. Must specify the direction.

‘Usage ‘sbp_add_port [-from <bit number>] [-to <bit number>] -direction <in/out/inout> <port_name>

4.2.6. sbp_connect_net

Connects all of the specified pins and/or ports to the same net. The arguments can be pins or ports in the system
design. Only one of the arguments can be the driver (output pin/port), driving all other input pin/ports. Example below
connects the clk port to all components, assuming component pins are all named clk.

Usage sbp_connect_net [-name <net name>] <pin/port> <pin/port>

Example sbp_connect_net [sbp_get_pins clk] {CLOCK_IN}

4.2.7. sbp_connect_interface_net

Connects a bus interface pin/port to another interface pin/port. This corresponds to the interconnection element in the
IP-XACT design.

‘Usage Isbp_connect_interface_net <pin/port> <pin/port>

4.2.8. sbp_connect_constant

Connects a constant integer to a pin/pinbus/port/portbus. To assign to a pin/pinbus, the object must be an input
pin/pinbus. To assign to a port/portbus, the object must be an output port/portbus. If the integer requires multiple
bits, not 0 or 1, then the object must be a bus. The tcl command can be used to assign the same constant to multiple
pin/pinbus/port/portbus at the same time.

Usage sbp_connect_constant -constant <integer> <pin/pin bus/ port/portbus> <pin/pin bus/
port/portbus>...
Example sbp_connect_constant -constant 1 {test/i2c_mst_apb/rst_n_i} {test/riscv/clk_i}
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4.2.9. sbp_connect_whitebox

User can do connection cross the hierarchy boundary for verification purpose.
Usage sbp_connect_whitebox <design_name/vip_inst_name/pin_name>
<design_name/uit_inst_name/port_name>

4.2.10.sbp_disconnect_whitebox

Removes the connection cross the hierarchy boundary.
Usage sbp_disconnect_whitebox <design_name/vip_inst_name/pin_name>
<design_name/uit_inst_name/port_name>

4.2.11.sbp_disconnect_interface_net

Disconnects an interface pin/port from the interface nets they attached to. Note that any interface pin or interface port
can attach to one interface net at the most.
‘Usage ‘sbp_disconnect_interface_net <pin/port> <pin/port>

4.2.12.sbp_disconnect_net

Disconnects all of the specified input pins and/or ports from the nets they attached to. Note that any pin or port can
attach to one net at the most. Can also be used to disconnect a constant that is connected to a pin/port with
connect_constant.

‘Usage ‘sbp_disconnect_net <pin0> <pinl> <port2>

4.2.13.sbp_assign_addr_seg

Assigns a memory map between a pair of master and slave interfaces. Range specifies the range of the segment, for
example, 32'h0000400, 32'h0001000. Offset specifies the base offset of the range, for example, 32‘h0000400
Usage sbp_assign_addr_seg -offset <offset> <slave connection name>

Example sbp_assign_addr_seg -offset 32‘h00001000 simple/riscv/AHBL_S00

4.2.14.sbp_unassign_addr_seg

The Tcl command unsets the fixed offset flag for a memory map allowing the auto_assign Tcl command to assign the
memory map offset.
Usage sbp_unassign_addr_seg <slave interface name>

Example sbp_unassign_addr_seg simple/spi/AHB_S00

4.2.15.sbp_assign_local_memory

Assigns a base address to a local memory map of a master address space.
Usage sbp_assign_local_memory -offset <offset> <master_addr_space>

Example sbp_assign_local_memory -offset ‘h0050000 Foundation_SoC/riscv/ahbl_m_data_Address_Space

4.2.16.sbp_export_pins

Exports a list of pins or interface pins, or all not-yet-connected pins of the components to the top-level port list in the
design. The function detects whether or not the argument is pin(s) or component(s). In the two examples below,
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Example 1 demonstrates a Tcl command to export the pin init_done, while Example 2 demonstrates a Tcl command to
export all pins and interfaces of the ddr3 component.

Usage sbp_export_pins <pin/component> <pin/component>
Example 1 sbp_export_pins {ddr3/init_done}
Example 2 sbp_export_pins {ddr3}

4.2.17.sbp_export_interface

Exports bus interfaces that are passed as arguments to the Tcl command from the component to the top-level
component. Example below exports the AHBL_MASTER bus interface of the RISC-V component to the top-level

component.
Usage sbp_export_interfaces <interface> <interface> <interface>
Example sbp_export_interfaces simple/riscv/AHBL_MASTER

4.2.18.sbp_rename

The rename Tcl command renames objects within the design. The new name of the object and the current hierarchical
name of the given object are used as the parameter value. The object can be an interface connection, connection, port,
interface, or component. The example below demonstrates the changing of the name of a port in milestone project
from CLK to CLOCK.

Usage

sbp_rename -name <new name> <object name>

Example

sbp_rename -name CLOCK milestone/CLK

4.2.19.sbp_replace

The Replace (Re-Config) Tcl command replaces a component with a new configuration for itself. VLNV refers to the
newly-generated IP, component name refers to the existing component that is to be replaced, and instance refers to
the instance name of the component with new configuration.

Usage

sbp_replace -vinv <VLNV> -name <instance> -component <component name>

Example

sbp_replace -vinv lattice:ip:ahblite_bus_0:1.1 -name ahbl_bus_0 -component simple/ahblite

4.2.20.sbp_copy

Copies objects, IP instances and nets, from the current or other open sbp designs to the current sbp design. All objects
are post-fixed with a postfix string. For example, you can write TCL code below to duplicate the components and
connections with new instance names post fixed with X, by calling copy on all the components, ports and nets. Pins are
automatically duplicated while the components are duplicated.

Usage

sbp_copy -postfix <postfixString> objects

Example

sbp_copy —postfix X Sselected_objs

4.2.21.sbp_delete

Deletes objects, IP instances and nets, from the current sbp design. In the examples below, Example 1 demonstrates a
Tcl command to delete a port, while Example 2 demonstrates a Tcl command to delete ddr3 component.

Usage Sbp_delete objects -type <type name>
Example 1 sbp_delete [sbp_get_ports <clock>] -type port
Example 2 sbp_delete {ddr3} -type component
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4.2.22.sbp_get_pins

Gets a list of pin names that match a pattern string, and/or the pins that are associated with an object. The object in
the [-from <objectName>] option can be a net or a component. The example below gets the clk pin from the
interconnect IP.

Usage sbp_get_pins [-from <object Name>] [pattern]

Example sbp_get_pins -from ahblite_interconnect clk

4.2.23.sbp_get_interface_pins

Gets a list of interface names that match a pattern string, and/or the interfaces that are associated with an object. The
object in the [-from <objectName>] option can be an interface net or a component. The example below can get all
AHB-Lite slave interface pins from the interconnect IP.

Usage: sbp_get_interface_pins [-from <objectName>] [pattern]

Example: sbp_get_interface_pins -from ahblite_interconnect S*_AHB

4.2.24.sbp_get_ports

Get a list of the names of ports that match a pattern string, and/or the ports that are associated with an object. The
object in the [-from <objectName>] option can be a net.
‘Usage ‘sbp_get_ports [-from <objectName>] [pattern]

4.2.25.sbp_get_interface_ports

Gets a list of interface names that match a pattern string, and/or the interface ports that are associated with an object.
The object in the [-from <objectName>] option can be an interface net.

‘Usage ‘sbp_get_interface_ports [-from <objectName>] [pattern]

4.2.26.sbp_get_nets

Gets a list of net names that match a pattern string, and/or the nets that are associated with an object. The object in
the [-from <objectName>] option can be a pin or a port.
‘Usage |sbp_get_nets [-from <objectName>] [pattern]

4.2.27.sbp_get_interface_nets

Gets a list of interface net names that match a pattern string, and/or the interface nets that are associated with an
object. The object in the [-from <objectName>] option can be an interface pin or an interface port.
‘Usage ‘sbp_get_interface_nets [-from <objectName>] [pattern]

4.2.28.sbp_set_property

Sets the properties of an input object. The first argument is a list of name value pairs. We have a list of parameters
because the GUI IP configuration dialog submits changes to many parameters of an IP component at the same time
when the dialog is closed. In the examples below, Example 1 changes the data width of the RAM block named “ebr_0",
while Example 2 changes the number of master interfaces to two and number of slave interface to three on AHB-Lite
interconnect block named “ahbl_interconnect”.

Usage sbp_set_property <name0O value0 namel valuel ...> object
Example 1 sbp_set_property {datawidth 32} {test/ebr_0}
Example 2 sbp_set_property {NUM_MI 2 NUM_SI 3} test/ahbl_interconnect
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4.2.29.sbp_get_property

Gets the property of the object. The example below is to get the number of slave interfaces of AHB-Lite interconnect
block named “ahbl_interconnect_0".

Usage sbp_get_property <parameter name> <object>

Example sbp_get_property NUM_SI ahbl_interconnect_0

4.2.30.sbp_report_properties

Prints all the properties and values associated to the type of the object.

Usage sbp_report_properties object

Example sbp_report_properties ahbl_interconnect

Outputs Name: ahbl_interconnect
NUM_SI: 1

NUM_MI: 2
DATA_WIDTH: 32
IADDRESS_WIDTH: 32

4.2.31.sbp_get_components

Gets a list of component names that match a pattern string, and/or the components that are associated with an object.
The default pattern string is a wildcard “*” that matches all components. The pattern string may consist of string
segments and wildcards. The example below returns all the component names that contain “interconnect”. The
command returns an empty string if no match is found.

Usage sbp_get_components <component name>

Example sbp_get_components {*interconnect*}
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Appendix A. metadata.xsd

<?xml version="1.0" encoding="gb2312"?>

<!-- IP Metadata Schema 0.0.4 -->
<t--
Change Log:

0.0.0 21-Jul-2016 initial revision.
0.0.1 22-Jul-2016 1. removed enum value from <setting> 2. change
value mapping to scriptType B
0.0.2 29-Jul-2016 1. removed GUI out of metadata scope
0.0.3 30-Jul-2016 1. add value list support
0.0.4 12-Dec-2020 1. all new features for radiant 3.0.
-—>
<xs:schema xmlns:xs="http://www.w3.0rg/2001/XMLSchema"
targetNamespace="http://www.latticesemi.com/XMLSchema/Radiant/ip"
xmlns:lsccip="http://www.latticesemi.com/XMLSchema/Radiant/ip"
elementFormDefault="qualified"
attributeFormDefault="unqualified">
<xs:include schemalLocation="busInterface.xsd"/>
<xs:include schemalocation="memoryMap.xsd"/>
<xs:include schemalocation="file.xsd"/>
<xs:include schemalLocation="generator.xsd"/>
<xs:include schemalocation="design.xsd"/>

<xs:attributeGroup name="ipany.att">
<xs:anyAttribute processContents="lax"/>
</xs:attributeGroup>
<!-- version string type definition-->
<xs:simpleType name="threeFigureVersionType">
<xs:annotation>
<xs:documentation>
The syntax for version string.
</xs:documentation>
</xs:annotation>
<xs:restriction base="xs:string">
<xs:pattern value="[0-9]+\.[0-9]1+\.[0-9]+"/>
</xs:restriction>
</xs:simpleType>

<xs:simpleType name="twoFigureVersionType">
<xs:annotation>
<xs:documentation>
The syntax for Radiant version string.
</xs:documentation>
</xs:annotation>
<xs:restriction base="xs:string">
<xs:pattern value="[0-9]+\.[0-9]+"/>
</xs:restriction>
</xs:simpleType>

<xs:simpleType name="scriptType">
<xs:annotation>
<xs:documentation>
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Any python expressions. Could be a simple const variable like
&quot;l&quot;,
or a tuple &quot; (0, 10)&quot;, or a function call
&quot;user funcl () &quot;,
or a complex expression &quot;a==l2&quot;
</xs:documentation>
</xs:annotation>
<xs:restriction base="xs:string"/>
</xs:simpleType>

<xs:simpleType name="settingTypeType">
<xs:annotation>
<xs:documentation>
Is this setting variable for parameter of IP core module, or just for
user input?
Valid values are &quot;inputé&quot; and &quot;param&quot; .
</xs:documentation>
</xs:annotation>
<xs:restriction base="xs:string">
<xs:enumeration value="param"/>
<xs:enumeration value="input"/>
<xs:enumeration value="command" />
</xs:restriction>
</xs:simpleType>

<xs:simpleType name="settingValueType">
<xs:annotation>
<xs:documentation>
Value type of setting variable. Valid types are &quot;boolé&quot;,
&quot;string&quot; and &quot;int&quot;
</xs:documentation>
</xs:annotation>
<xs:restriction base="xs:string">
<xs:enumeration value="bool"/>
<xs:enumeration value="string"/>
<xs:enumeration value="int"/>
<xs:enumeration value="float"/>
<xs:enumeration value="path"/>
</xs:restriction>
</xs:simpleType>

<xs:simpleType name="settingDefaultType">
<xs:annotation>
<xs:documentation>
Default value of setting wvariable.
</xs:documentation>
</xs:annotation>
<xs:restriction base="xs:string"/>
</xs:simpleType>

<xs:simpleType name="settingOutputFormatterType">
<xs:annotation>
<xs:documentation>
Formatter of output.
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</xs:documentation>
</xs:annotation>
<xs:restriction base="xs:string">
<xs:enumeration value="str"/>
<xs:enumeration value="nostr"/>
</xs:restriction>
</xs:simpleType>

<!-- ip.settings.setting-->
<xs:complexType name="settingElementType">
<xs:annotation>
<xs:documentation>
Setting variable definition.
</xs:documentation>
</xs:annotation>

<xs:attribute name="id" type="xs:string" use="required" />

<xs:attribute name="type" type="lsccip:settingTypeType"
use="required" />

<xs:attribute name="value type" type="lsccip:settingValueType"
use="required" />

<xs:attribute name="conn mod" type="xs:string" use="required" />

<xs:attribute name="default" type="lsccip:settingDefaultType"
use="optional" />

<xs:attribute name="value expr" type="lsccip:scriptType"
use="optional" />

<xs:attribute name="drc" type="lsccip:scriptType" use="optional" />

<xs:attribute name="editable" type="lsccip:scriptType"
use="optional" />

<xs:attribute name="description" type="xs:string" use="optional" />

<xs:attribute name="title" type="xs:string" use="optional" />

<xs:attribute name="hidden" type="xs:string" use="optional" />

<xs:attribute name="regex" type="xs:string" use="optional" />

<xs:attribute name="options" type="lsccip:scriptType"
use="optional" />

<xs:attribute name="value range" type="lsccip:scriptType"
use="optional" />

<xs:attribute name="groupl" type="xs:string" use="optional" />

<xs:attribute name="group2" type="xs:string" use="optional" />

<xs:attribute name="bool value mapping" type="lsccip:scriptType"
use="optional" />

<xs:attribute name="output formatter"
type="1sccip:settingOutputFormatterType" use="optional"™ />

<xs:attribute name="config groups" type="lsccip:scriptType"
use="optional" />

<xs:attribute name="process path" type="xs:boolean" use="optional"

default="true"></xs:attribute> B
</xs:complexType>

<!-- ip.settings -->
<xs:complexType name="settingsType">
<xs:sequence>
<xs:element minOccurs="0" maxOccurs="unbounded" name="setting"
type="1lsccip:settingElementType" />
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</xs:sequence>
</xs:complexType>

<!-- ip.ports.port-->
<xs:complexType name="portElementType">

<xs:annotation>
<xs:documentation>IP port definition.</xs:documentation>

</xs:annotation>

<xs:attribute name="name" type="xs:string" use="required" />

<xs:attribute name="dir" type="xs:string" use="required" />

<xs:attribute name="conn mod" type="xs:string" use="required" />

<xs:attribute name="conn port" type="xs:string" use="optional" />

<xs:attribute name="conn range" type="xs:string" use="optional" />

<xs:attribute name="range" type="lsccip:scriptType"
use="optional" />

<xs:attribute name="stick high" type="lsccip:scriptType"
use="optional" />

<xs:attribute name="stick low" type="lsccip:scriptType"
use="optional" />

<xs:attribute name="stick value" type="lsccip:scriptType"
use="optional" />

<xs:attribute name="dangling" type="lsccip:scriptType"
use="optional" />

<xs:attribute name="bus interface" type="xs:string"
use="optional" />

<xs:attribute name="attribute" type="lsccip:scriptType"
use="optional" />

<xs:attribute name="port type" use="optional" default="data">
<xs:simpleType>

<xs:restriction base="xs:string">

<xs:enumeration
<xs:enumeration
<xs:enumeration

value="data"></xs:enumeration>
value="reset"></xs:enumeration>
value="clock"></xs:enumeration>

</xs:restriction>
</xs:simpleType>
</xs:attribute>
</xs:complexType>
<!-- ip.outFileConfigs -->
<xs:complexType name="outFileConfigsType">
<xs:sequence>
<xs:element maxOccurs="unbounded" name="fileConfig"
type="1lsccip:fileConfigType" />
</xs:sequence>
</xs:complexType>
<!-- ip.outFileConfigs.fileConfig —-->
<xs:complexType name="fileConfigType">
<xs:annotation>
<xs:documentation>Configure output file</xs:documentation>
</xs:annotation>
<xs:attribute name="name" type="xs:string" use="required"
<xs:attribute name="use" use="optional" default="merge">
<xs:annotation>
<xs:documentation>
Merge the new attributes to existing configuration or

/>
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replace all
</xs:documentation>
</xs:annotation>
<xs:simpleType>
<xs:restriction base="xs:string">
<xs:enumeration value="merge"></xs:enumeration>
<xs:enumeration value="replace"></xs:enumeration>
</xs:restriction>
</xs:simpleType>
</xs:attribute>
<xs:attribute name="type" use="optional" default="file">
<xs:annotation>
<xs:documentation>
Indicate the item is generate a file or directory
</xs:documentation>
</xs:annotation>
<xs:simpleType>
<xs:restriction base="xs:string">
<xs:enumeration value="file"></xs:enumeration>
<xs:enumeration value="directory"></xs:enumeration>
</xs:restriction>
</xs:simpleType>
</xs:attribute>
<xs:attribute name="description" type="xs:string"
use="optional">
</xs:attribute>
<xs:attribute name="enable output" type="xs:string" use="optional"
default="True">
<xs:annotation>
<xs:documentation>
Python expression represent a boolean value to
indicate the output is enabled or disabled
</xs:documentation>
</xs:annotation>
</xs:attribute>
<xs:attribute name="phase" type="xs:int" use="optional"
default="0">
</xs:attribute>
<xs:attribute name="file base name" type="xs:string"
use="optional">
</xs:attribute>
<xs:attribute name="file suffix" type="xs:string"
use="optional">
</xs:attribute>
<xs:attribute name="sub dir" type="xs:string"
use:"optional"></xs:attribute;
<xs:attribute name="file generator" type="xs:string"
use="optional">
</xs:attribute>
<xs:attribute name="src dir" type="xs:string"
use="optional">
</xs:attribute>
<xXs:attribute name="dest dir" type="xs:string"
use="optional">
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</xs:attribute>
<xs:attribute name="src file" type="xs:string"
use="optional">
</xs:attribute>
<xs:attribute name="export" use="optional" default="input only">
<xs:annotation>
<xs:documentation>
Indicate export all setting items or input only
</xs:documentation>
</xs:annotation>
<xs:simpleType>
<xs:restriction base="xs:string">
<xs:enumeration value="all"></xs:enumeration>
<xs:enumeration value="input only"></xs:enumeration>
</xs:restriction>
</xs:simpleType>
</xs:attribute>
<xs:attributeGroup ref="lsccip:ipany.att"/>
</xs:complexType>
<!-- ip.interface-->
<xs:complexType name="portsType">
<xs:sequence>
<xs:element maxOccurs="unbounded" minOccurs="1" name="port"
type="1lsccip:portElementType" />
</xs:sequence>
</xs:complexType>

<!-- ip.interface-->
<xs:complexType name="generalType">
<xs:sequence>

<xs:element maxOccurs="1" minOccurs="0" name="vendor"
type="xs:string" />

<xs:element maxOccurs="1" minOccurs="0" name="library"
type="xs:Name" />

<xs:element maxOccurs="1" minOccurs="1" name="name"
type="xs:string" />

<xs:element maxOccurs="1" minOccurs="0" name="display name"
type="xs:string" />

<xs:element maxOccurs="1" minOccurs="1" name="version"
type="xs:string" />

<xs:element maxOccurs="1" minOccurs="1" name="category"
type="xs:string" />

<xs:element maxOccurs="1" minOccurs="0" name="keywords"
type="xs:string" />

<xs:element maxOccurs="1" minOccurs="0" name="type"
type="xs:string" />

<xs:element maxOccurs="1" minOccurs="0" name="instantiatedOnce"
type="xs:boolean" />

<xs:element maxOccurs="1" minOccurs="1"

name="min radiant version" type="lsccip:twoFigureVersionType" />

<xs:element maxOccurs="1" minOccurs="0"

name="max radiant version" type="lsccip:twoFigureVersionType" />

<xs:element maxOccurs="1" minOccurs="0" name="min esi version"
type="1sccip:twoFigureVersionType" />
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<xs:element maxOccurs="1" minOccurs="0" name="max esi version"
type="1lsccip:twoFigureVersionType" />
<xs:element maxOccurs="1" minOccurs="1"
name="supported products" type="lsccip:supportedProductsType" />
<xs:element maxOccurs="1" minOccurs="0"
name="supported platforms" type="lsccip:supportedPlatformsType" />
</xs:sequence>
</xs:complexType>

<xs:complexType name="supportedPlatformsType">
<xs:sequence>
<xs:element maxOccurs="unbounded" minOccurs="1" name="supported platform"
type="1sccip:supportedPlatformType" /> B
</xs:sequence>
</xs:complexType>

<xs:complexType name="supportedPlatformType">
<xs:attribute name="name" type="xs:string"/>
</xs:complexType>

<xs:complexType name="supportedProductsType">
<xs:sequence>
<xs:element maxOccurs="unbounded" minOccurs="1" name="supported family"
type="1sccip:supportedFamilyType" /> -
</xs:sequence>
</xs:complexType>

<xs:complexType name="supportedFamilyType">
<xs:sequence>
<xs:element maxOccurs="unbounded" minOccurs="0" name="supported device"
type="1sccip:supportedDeviceType" /> B
</xs:sequence>
<xs:attribute name="name" type="xs:string"/>
</xs:complexType>

<xs:complexType name="supportedDeviceType">
<xs:sequence>
<xs:element maxOccurs="unbounded" minOccurs="0"
name="supported speed grade" type="lsccip:supportedSpeedType" />
</xs:sequence>
<xs:attribute name="name" type="xs:string"/>
</xs:complexType>

<xs:complexType name="supportedSpeedType">
<xs:sequence>
<xs:element maxOccurs="unbounded" minOccurs="0" name="supported package"
type="1lsccip:supportedPackageType" /> B
</xs:sequence>
<xs:attribute name="name" type="xs:string"/>
</xs:complexType>

<xs:complexType name="supportedPackageType">
<xs:attribute name="name" type="xs:string"/>
</xs:complexType>
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<!-- ip.estimatedResources -->
<xs:complexType name="estimatedResourcesType">
<xs:annotation>
<xs:documentation>
IP estimated resources definition.
</xs:documentation>
</xs:annotation>
<xs:sequence>
<xs:element name="estimatedResource" type="lsccip:estimatedResourceType"
minOccurs="1" maxOccurs="unbounded" />
</xs:sequence>
</xs:complexType>

<xs:complexType name="estimatedResourceType">
<xs:sequence>
<xs:element name="name" type="xs:string"/>
<xs:element name="number" type="xs:string"/>
</xs:sequence>
</xs:complexType>

<!-- ip -->
<xs:element name="ip">
<xs:complexType>
<xs:sequence>
<xs:element name="general" type="lsccip:generalType" />
<xs:element name="settings" type="lsccip:settingsType" />
<xs:element name="ports" type="lsccip:portsType" />
<xs:element name="outFileConfigs" type="lsccip:outFileConfigsType"
maxOccurs="1" minOccurs="0">
<xs:unique name="fileCfgKey">
<xs:selector xpath="lsccip:fileConfig"/>
<xs:field xpath="@name"/>
</xs:unique>
</xs:element>
<xs:element ref="lsccip:busInterfaces" minOccurs="0" />
<xs:element ref="lsccip:addressSpaces" minOccurs="0" />
<xs:element ref="lsccip:memoryMaps" minOccurs="0" />
<xs:element ref="lsccip:componentGenerators" minOccurs="0" />
<xs:element ref="lsccip:choices" minOccurs="0" />
<xs:element ref="lsccip:fileSets" minOccurs="0" />
<xs:element ref="lsccip:design" minOccurs="0"
maxOccurs="unbounded" />
<xs:element name="estimatedResources"
type="1lsccip:estimatedResourcesType" minOccurs="0" />
<xs:element ref="lsccip:parameters" minOccurs="0" />
</xs:sequence>
<xs:attribute name="version" type="lsccip:twoFigureVersionType"/>
</xs:complexType>
</xs:element>

</xs:schema>
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Technical Support Assistance

Submit a technical support case through www.latticesemi.com/techsupport.
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